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Zřeknutí se odpovědnosti 

 
UPOZORNĚNÍ! 
Výchozí heslo se používá pro první přihlášení. Chcete-li zajistit bezpečnost účtu, změňte heslo po prvním 
přihlášení. Doporučuje se nastavit silné heslo (nejméně osm znaků). 

 

 Popsaný produkt i s hardwarem, softwarem, firmwarem a dokumenty, v maximální možné míře, 
povolené platnými zákony, je poskytován formou "tak, jak je". 

 Na ověření integrity a správnosti obsahu v této příručce bylo vynaloženo maximální úsilí, avšak žádné 
tvrzení, informace ani doporučení v této příručce nepředstavují formální záruku žádného druhu, 
vyjádřenou ani předpokládanou. Nezodpovídáme za žádné technické nebo typografické chyby v této 
příručce. Obsah této příručky se může změnit bez předchozího upozornění. Aktualizace budou přidány 
do nové verze této příručky. 

 Použití této příručky a následných výsledků je zcela na vlastní odpovědnost uživatele. V žádném 
případě nebudeme zodpovědní za jakékoliv zvláštní, následné, náhodné nebo nepřímé škody, včetně 
mimo jiné škod způsobených ztrátou obchodních zisků, přerušením podnikání nebo ztrátou dat nebo 
dokumentace v souvislosti s používáním tohoto výrobku. 

 Video a audio sledování mohou být upraveny zákony, které se v jednotlivých zemích liší. Před použitím 
tohoto produktu pro účely sledování si nejprve ověřte zákony ve vaší oblasti. Nezodpovídáme za žádné 
důsledky vyplývající z nelegálního provozu zařízení. 

 Obrázky v této příručce jsou pouze orientační a v závislosti na verzi nebo modelu se mohou lišit. 
Snímky obrazovky v této příručce mohou být přizpůsobeny tak, aby vyhovovaly konkrétním 
požadavkům a uživatelským preferencím. Proto se některé z uvedených příkladů a funkcí mohou lišit 
od těch, které jsou zobrazeny na vašem monitoru. 

 V této příručce jsou uvedeny pokyny pro více modelů výrobků, a proto není určena pro žádný 
konkrétní výrobek. 

 Z důvodu proměnných, jako je například fyzické prostředí, může existovat nesrovnalost mezi 
skutečnými hodnotami a referenčními hodnotami uvedenými v této příručce. Konečné právo na výklad 
spočívá na naší společnosti. 



 

Ochrana životního prostředí 
Tento výrobek byl navržen tak, aby vyhovoval požadavkům na ochranu životního prostředí. Pro správné 
skladování, používání a likvidaci tohoto výrobku je třeba dodržovat národní zákony a předpisy. 

Symboly 

V této příručce naleznete symboly uvedené v následující tabulce. Pečlivě dodržujte pokyny označené 
symboly, abyste předešli nebezpečným situacím a produkt používali náležitým způsobem. 

Symbol Popis 

VAROVÁNÍ! 
Obsahuje důležité bezpečnostní pokyny a upozorňuje na situace, které by mohly 
způsobit zranění. 

UPOZORNĚNÍ! 
Znamená, že čtenář má být opatrný a že při nesprávné činnosti může dojít k 
poškození nebo selhání výrobku. 

ZAPAMATUJTE SI! Znamená užitečné nebo doplňující informace o použití produktu. 
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1 

1  Sítové připojení 

Před přístupem k síťové kameře (známé také jako IP kamera nebo IPC) z počítače je nutné připojit síťovou 
kameru k počítači přímo pomocí síťového kabelu nebo pomocí přepínače či směrovače. 

 
K připojení síťových rozhraní síťové kamery a počítače použijte kabel stíněné kroucené dvoulinky (STP). 

 

Použijte kabely stíněné kroucené dvoulinky (STP) pro připojení síťových rozhraní kamery a přepínače nebo 
směrovače. 

2  Přihlášení 

Příprava 
Po dokončení instalace v souladu s úvodní příručkou připojte kameru k napájení, aby se spustila. Po 
spuštění kamery můžete přistupovat ke kameře z klientského počítače, v němž je nainstalován webový 
prohlížeč nebo klientský software EZStation. Doporučený webový prohlížeč je Internet Explorer (IE). Další 
informace o softwaru EZStation naleznete v Uživatelské příručce k softwaru EZStation. 

V následující části je jako příklad uveden prohlížeč IE v operačním systému Microsoft Windows 7.0. 

Kontrola před přihlášením 

 Kamera pracuje správně. 

 Síťové připojení mezi počítačem a kamerou je normální. 

 V počítači je nainstalována aplikace Internet Explorer 8.0 nebo novější. 

 Rozlišení je nastaveno na 1440 × 900 (volitelné). 

Network cable

IPC PC

IPC PCSwitch or Router

Network cable Network cable

Síťový kabel 

Síťový kabel 

Přepínač nebo směrovač 

Síťový kabel 

Počítač IPC 

Počítač IPC 
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Přidání adresy IP jako důvěryhodné webové stránky 

 

 

1

2

http://192.168.0.13

3
4

5

6
Clear the check box

7

Zrušte zaškrtnutí políčka. 
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 ZAPAMATUJTE SI! 
Adresa IP 192.168.0.13/192.168.1.13 v tomto příkladu je výchozí adresa IP. Nahraďte ji skutečnou adresou 
kamery, pokud byla změněna. 

 

Úprava nastavení kontroly přístupu uživatele (volitelně) 

Před přístupem ke kameře postupujte podle pokynů a nastavte možnost User Account Control Settings na 
hodnotu Never notify. 

 

Přihlášení k webovému rozhraní 

Výchozí statická adresa IP kamery je 192.168.1.13 nebo 192.168.0.13 a výchozí maska podsítě je 
255.255.255.0. 

Protokol DHCP je ve výchozím nastavení zapnut. Pokud je v síti použit server DHCP, adresa IP kamery může 
být přiřazena dynamicky a pro přihlášení bude nutné použít správnou adresu IP. K zobrazení dynamické 
adresy IP kamery použijte klienta EZStation. 

Níže je jako příklad pro popis postupu přihlášení uvedena aplikace IE. 

1. Přejděte na přihlašovací stránku zadáním správné adresy IP kamery do adresního řádku. 

 

2. Pokud se přihlašujete poprvé, postupujte podle pokynů systému a nainstalujte ovládací prvek ActiveX. 
Chcete-li dokončit instalaci, je nutné zavřít prohlížeč. 

1

2

3

4



4 

 ZAPAMATUJTE SI! 
 Chcete-li manuálně načíst ovládací prvek ActiveX, zadejte do adresního řádku text  

http://adresa IP/ActiveX/Setup.exe a stiskněte klávesu Enter. 
 Výchozí heslo se používá pro první přihlášení. Chcete-li zajistit bezpečnost účtu, změňte heslo  

po prvním přihlášení. Doporučuje se nastavit silné heslo (nejméně osm znaků). 
 Kamera se chrání před nelegálním přístupem tím, že omezuje počet neúspěšných pokusů o 

přihlášení. Pokud přihlášení selže šestkrát za sebou, kamera se na deset minut automaticky 
zablokuje. 

 

3. Zadejte uživatelské jméno a heslo a poté klikněte na tlačítko Login. Pro první přihlášení použijte 
výchozí uživatelské jméno „admin“ a heslo „123456“. 

 Pokud se přihlásíte s vybranou položkou Live View, zobrazí se po přihlášení živé zobrazení. V opačném 
případě je nutné spustit živé zobrazení ručně v okně živého zobrazení. 

 Pokud se přihlásíte s vybranou položkou Save Password, nebude nutné zadávat heslo při každém 
přihlášení. Pro zajištění bezpečnosti však výběr položky Save Password nedoporučujeme. 

 A chcete-li vymazat textová pole Username a Password a zaškrtávací políčko Save Password, klikněte 
na možnost Reset.  

Úvod k webovému rozhraní 

Ve výchozím nastavení se po přihlášení k webovému rozhraní zobrazí okno živého zobrazení. Následuje 
příklad. 

 

Č. Popis 

1 Nabídka 

2 
Oblast ovládání PTZ 

Poznámka: 
Tato oblast je k dispozici pro kopulovité kamery PTZ a kamery PTZ. 

3 Okno živého zobrazení 

4 Panel nástrojů živého zobrazení 

 

1

2

3

4
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Počáteční konfigurace 

Po přihlášení k zařízení proveďte následující počáteční konfiguraci. 

Položka Popis 

1. Nastavte adresu TCP/IP zařízení. Překonfigurujte adresu IP zařízení a síťové parametry podle 
skutečné sítě. 

2. Odhlaste se a přihlaste se znovu k 
webu pomocí nové adresy IP. - 

3. Nastavte čas systému. Nastavte systémový čas podle aktuální situace. 

4. (Volitelné) Nastavte server správy. Nastavte server správy podle skutečné sítě. 

5. Nastavte server pro ukládání 
fotografií (volitelné). Nastavte server pro uložení fotografií podle skutečné sítě. 

6. Nastavte OSD. Na displeji nastavte podle potřeby určité údaje, například čas. 

7. Spravujte uživatele (volitelné). Změňte výchozí heslo a podle potřeby přidejte běžné uživatele. 

 

Po ukončení počáteční konfigurace můžete sledovat živé zobrazení. Další parametry nakonfigurujte podle 
potřeby. 

 ZAPAMATUJTE SI! 
 Zobrazované rozhraní živého zobrazení, zobrazené parametry a rozsahy hodnot se mohou u 

jednotlivých modelů lišit. Podrobnosti naleznete v aktuálním webovém rozhraní. 
 Parametry, které jsou zašedlé, nelze změnit. Aktuální nastavení viz webové rozhraní. 
 Po prvním přihlášení se doporučuje změnit heslo. Podrobné informace o změně hesla naleznete v 

tématu Zabezpečení 

 

3  Konfigurace parametrů 

Místní parametry 

Nastavte místní parametry pro počítač. 

 ZAPAMATUJTE SI! 
Místní parametry se mohou u jednotlivých modelů lišit. Podrobnosti naleznete v aktuálním webovém rozhraní. 
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1. Vyberte možnost Setup > Common > Local Settings. 

 

2. Upravte nastavení podle potřeby. V následující tabulce jsou popsány některé hlavní parametry. 

Parametr Popis 

Intelligent 
Mark 

Untriggered 
Target 

Po zapnutí zobrazí kamera na obrazovce značku cíle na obrazovce (např. tvář 
při detekci obličeje) a sleduje ji. 

Video 

Processing Mode 

 Priorita v reálném čase: Doporučeno, pokud je síť v dobrém stavu. 
 Priorita plynulost: Doporučeno, chcete-li zkrátit prodlevu živého videa. 
 Velmi nízká latence: Doporučeno, chcete-li minimální časovou prodlevu 

pro živé video. 

Protocol Nastavte protokol použitý pro přenos mediálních streamů, které mají být 
dekódovány počítačem. 

Record 
and 
Snapshot 

Recording 

 Ukládání dle délky dílčího záznamu: Délka zaznamenaného videa pro 
každý soubor záznamu v počítači. Například 2 minuty. 

 Ukládání dle velikosti dílčího záznamu: Velikost každého souboru záznamu 
uloženého v počítači. Například 5 MB. 

Record 
Overwrite 

 Přepsat: Po vyčerpání přiděleného úložného prostoru v počítači odstraní 
kamera stávající soubory záznamu, čímž vytvoří prostor pro nový soubor 
záznamu. 

 Úplné zastavení: Pokud je přidělený úložný prostor v počítači plný, 
nahrávání se automaticky zastaví. 

 

3. Klikněte na možnost Save. 
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Konfigurace sítě 

Ethernet 

Změňte nastavení komunikace, například adresu IP kamery, aby kamera mohla komunikovat s jinými 
zařízeními. 

 ZAPAMATUJTE SI! 
 Po změně adresy IP je nutné pro přihlášení použít novou adresu IP. 
 Konfigurace serveru DNS (Domain Name System) jsou použitelné, pokud je zařízení přístupné podle 

názvu domény. 

 

Statická adresa 

1. Klikněte na možnost Setup > Network > Network. 

  
2. Vyberte možnost Static z rozevírací nabídky Obtain IP Address. 

3. Zadejte adresu IP, masku podsítě a výchozí adresu brány. Ujistěte se, že IP adresa kamery je v síti 
jedinečná. 

4. Klikněte na možnost Save. 

PPPoE 

 ZAPAMATUJTE SI! 
Tato funkce není u některých modelů podporována. Podrobnosti naleznete u aktuálního modelu. 

 

Je-li kamera připojena k síti přes „Point to Point over Ethernet“ (PPPoE), je nutné zvolit možnost PPPoE jako 
režim získání adresy IP. 
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1. Klikněte na možnost Setup > Network > Network. 

 

2. Vyberte možnost PPPoE z rozevírací nabídky Obtain IP Address. 

3. Zadejte uživatelské jméno a heslo, které poskytl váš poskytovatel internetových služeb (ISP). 

4. Klikněte na možnost Save. 

DHCP 

Protokol DHCP (Dynamic Host Configuration Protocol) je ve výchozím nastavení při dodání kamery povolen. 
Pokud je v síti nasazen server DHCP, může kamera automaticky získat adresu IP ze serveru DHCP. 

Chcete-li protokol DHCP konfigurovat ručně, postupujte takto: 

1. Klikněte na možnost Setup > Network > Network. 

 

2. Vyberte možnost DHCP z rozevírací nabídky Obtain IP Address. 

3. Klikněte na možnost Save. 

IPv6 

1. Klikněte na možnost Setup > Network > Network. 
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2. Ve výchozím nastavení je režim IPv6 nastaven na možnost Manual. 

3. Zadejte adresu IPv6, nastavte délku předpony a výchozí bránu. Adresa IP musí být v síti jedinečná. 

4. Klikněte na možnost Save. 

Wi-Fi 

 ZAPAMATUJTE SI! 
Tuto funkci některé modely nepodporují. Podrobnější informace naleznete u aktuálního modelu. 

1. Klikněte na možnost Setup > Network > Network. Klikněte na kartu Wi-Fi. 

 
2. Vyberte možnost Sniffer. 

3. Klikněte na možnost Save. 

Některá zařízení mohou vyhledat sítě Wi-Fi a připojit se. 

1. Vyberte možnost Setup > Network > Network. Vyberte možnost Wi-Fi v nabídce Wi-Fi Mode. 
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2. Zobrazí se síla signálu. Zapněte možnost Adaptive Streams. Na stránce se zobrazí, že existují další sítě 
Wi-Fi. Chcete-li znovu vyhledat sítě Wi-Fi, klikněte na možnost Search. 

3. V seznamu sítí Wi-Fi klikněte na identifikátor SSID. Zobrazí se informace o příslušné síti. 

4. Klikněte na možnost Save. 

5. Pokud je možnost Wi-Fi Mode nastavena na položku Wi-Fi Hotspot, může kamera fungovat jako 
hotspot Wi-Fi pro ostatní zařízení. 

 

6. Klikněte na možnost Save. 

Port 

 ZAPAMATUJTE SI! 
Tato funkce není u některých modelů podporována. Podrobnosti naleznete u aktuálního modelu. 

1. Klikněte na možnost Setup > Network > Port. 

 
2. Nakonfigurujte příslušná čísla portů. 

3. Klikněte na možnost Save. 
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FTP 

Po konfiguraci FTP budete moci odeslat snímky ze síťových kamer na určený server FTP. 

Obecné 

1. Klikněte na možnost Setup > Storage > FTP. Přejděte na kartu General. 

 
2. Nastavte adresu IP a port pro server FTP, uživatelské jméno a heslo, které se používají k odesílání 

snímků na server FTP, vyberte možnosti Upload Images, Overwrite Storage a nastavte možnost 
Overwrite At (práh pro přepsání obrázků). Některé modely kamer podporují test FTP. FTP můžete 
otestovat po správném dokončení nastavení FTP. 

3. Nastavte cestu k ukládání snímků na server FTP a formát názvu souboru. Například nastavte cestu jako 
Č. předvolby\\Adresa IP\\Datum\\Hodina a nastavte název souborů jako Č. předvolby-Zoom 
PTZ-Zeměpisná šířka PTZ-Zeměpisná délka PTZ.jpg. 

4. Klikněte na možnost Save. 

Inteligentní 

Tato funkce se používá k ukládání snímků pořízených pro inteligentní funkce, jako je rozpoznávání obličeje a 
počítání osob. 
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1. Klikněte na možnost Setup > Storage > FTP. Přejděte na kartu Smart. 

 
2. Nastavte adresu IP a port serveru FTP, uživatelské jméno a heslo, které se používají k odesílání snímků 

na server FTP. 

3. Nastavte cestu k ukládání snímků na server FTP a formát názvu souboru. Například nastavte cestu jako 
Č. předvolby\\Adresa IP\\Datum a nastavte název souboru jako Č. předvolby-Zeměpisná šířka 
PTZ-Zeměpisná délka PTZ-Zoom PTZ.jpg. 

4. Klikněte na možnost Save. 

E-mail 

Po konfiguraci e-mailu budete moci při spuštění alarmu odesílat zprávy na zadanou e-mailovou adresu. 
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1. Klikněte na možnost Setup > Network > E-mail. 

 

2. Nakonfigurujte příslušné parametry odesílatele a příjemce. Některé modely kamer podporují test 
e-mailu. Po nastavení adresy příjemce můžete e-mail otestovat. V následující tabulce jsou popsány 
některé hlavní parametry. 

Parametr Popis 

TLS/SSL 

Pokud je tato možnost povolena, budou e-maily šifrovány pomocí protokolu TLS (Transport 
Layer Security) nebo Secure Socket Layer (SSL) pro ochranu soukromí. 

Nejprve se systém pokusí odeslat e-mail přes připojení SSL. Pokud server SMTP podporuje 
protokol SSL, bude e-mail odeslán prostřednictvím připojení SSL; jinak se jej pokusí odeslat 
pomocí protokolu STARTTLS. 

Attach Image Pokud je možnost povolena, bude e-mail obsahovat 3 snímky jako přílohu podle intervalů 
zachycování snímku. 

3. Klikněte na možnost Save. 

Mapování portů  

1. Klikněte na možnost Setup > Network > Port. Přejděte na kartu Port Mapping. 
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2. Povolte možnost Port Mapping a vyberte typ mapování. Je-li vybrána možnost Manual, pak musí být 
nakonfigurovány externí porty (kamera získává automaticky externí adresu IP). Pokud je 
nakonfigurovaný port obsazen, pak bude možnost Status zobrazena jako neaktivní. 

3. Klikněte na možnost Save. 

DNS 

1. Klikněte na možnost Setup > Network > DNS. 

 

2. Nastavte adresy serverů DNS. 

3. Klikněte na možnost Save. 

DDNS  

 ZAPAMATUJTE SI! 
Tato funkce není u některých modelů podporována. Podrobnosti naleznete u aktuálního modelu. 

 

1. Klikněte na možnost Setup > Network > DDNS. 

 

2. Povolte možnost DDNS Service. 

3. Vyberte typ DDNS: DynDNS, NO-IP nebo EZDDNS. 

4. Dokončete další nastavení včetně adresy serveru, názvu domény, uživatelského jména a hesla. 

5. Klikněte na možnost Save. 

EZCloud 

 ZAPAMATUJTE SI! 
 Tato funkce není dostupná pro všechny modely. 
 Tato funkce se u některých zařízení zobrazuje jako P2P. 

 

1. Klikněte na možnost Setup > Network > EZCloud. 
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2. Vyberte možnost On a povolte cloudovou službu. 

3. Klikněte na možnost Save. 

802.1x 

Technologie 802.1x poskytuje ověřování zařízení (např. kamer), které se pokouší připojit k síti. Pouze 
ověřená zařízení se mohou připojit k síti. To zvyšuje bezpečnost. 

1. Klikněte na možnost Setup > Network > 802.1x. 

 
2. Vyberte možnost On a poté dokončete další nastavení. 

3. Klikněte na možnost Save. 

Konfigurace obrazu 

Nastavení obrazu 

 ZAPAMATUJTE SI! 
 Zobrazené parametry obrazu a povolené rozsahy hodnot se mohou u jednotlivých modelů kamer lišit. 

Informace o skutečných parametrech a rozsazích hodnot kamery naleznete ve webovém rozhraní. 
Přesunutím posuvníků můžete upravit nastavení nebo zadat hodnoty přímo do textových polí. 

 Při kliknutí na možnost Default se obnoví všechna výchozí nastavení obrazu. 

 

Nastavení scény 

Nastavte parametry obrazu pro dosažení požadovaných obrazových efektů založených na živém videu v 
různých scénách. 

Klikněte na možnost Setup > Image > Image. 

Stránka pro správu scén je pro některé modely zobrazena následujícím způsobem, v rozevíracím seznamu 
můžete vybrat požadovanou scénu. 
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Stránka pro správu scén je u některých modelů zobrazena následovně, pro nastavení scény můžete provést 
následující kroky. 

 
1. Klikněte na možnost Scenes. 

2. Vyberte určitou scénu a poté nastavte parametry přepínání scén. V následující tabulce jsou popsány 
některé hlavní parametry. 

Sloupec Popis 

Current 

Označuje scénu, která se používá. 

Poznámka: 
 Zvolte tlačítko možností pro přepnutí na scénu a zobrazení odpovídajících parametrů 

obrazu dané scény. 
 Kamera automaticky přepne aktuální scénu, když je vybrána možnost Enable Auto 

Switching. 

Scene Name 

Název aktuální scény. Zařízení poskytuje několik přednastavených režimů scény. Když 
vyberete určitou scénu, zobrazí se odpovídající parametry obrazu. Nastavení obrazu můžete 
upravit podle skutečných potřeb. 

 Vlastní: doporučeno pro venkovní scény. 
 Vnitřní: doporučeno pro scény v interiéru. 
 Vysoká citlivost: doporučeno pro prostředí s nízkou úrovní osvětlení. 
 Zvýraznění kompenzace: může potlačit silné světlo, jako jsou světlomety na silnicích a 

reflektory v parcích. Doporučeno pro zachycení registračních značek vozidel. 
 WDR: doporučeno pro scény s vysokým světelným kontrastem, např. okna, chodby, 

přední dveře nebo jiné scény, které jsou světlé venku, avšak uvnitř jsou tlumené. 
 Vlastní: Nastavte název scény podle potřeby. 
 Líc: Zachycuje tváře v pohybu v komplikovaných scénách. 

Auto 
Switching 

Označuje, zda chcete přidat scénu do seznamu automatického přepínání. 

Poznámka: 
Je-li zvolena možnost Auto Switching, systém automaticky přepne na scénu, pokud je 
splněna podmínka pro přepnutí na scénu. Ve výchozím nastavení obsahuje seznam 
automatického přepínání výchozí scénu. 

Setup 

Kliknutím na možnost  nastavíte podmínky pro automatické přepínání, včetně plánu, 
osvětlení a aktuální hodnoty (úhel mezi PTZ a horizontálním směrem). To znamená, že 
automatické přepínání se spouští pouze tehdy, když osvětlení a aktuální nadmořská výška 
během nastaveného časového období splňují nastavené podmínky. Podmínka je neplatná, 
pokud je počáteční i koncová hodnota nastavena na hodnotu 0. 
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3. Vyberte scénu a poté ji kliknutím na možnost  nastavte jako výchozí scénu. 
4. Je-li povoleno automatické přepínání, kamera se automaticky přepne na scénu, pokud je splněna 

podmínka pro přepnutí na jinou než výchozí scénu. V opačném případě zůstává kamera na výchozí 
scéně. Pokud není zapnuto automatické přepínání, zůstane kamera na aktuální scéně. 

 ZAPAMATUJTE SI! 
 Je-li zapnuto automatické přepínání (nastavení scény nebudou k dispozici), zařízení bude přepínat 

mezi nastavenými scénami. Pokud tomu tak není, zařízení zůstane na aktuální scéně. Zařízení 
zůstane na výchozích scénách, pokud nebudou aktivovány jiné než výchozí scény. 

 Pokud je spuštěno několik jiných než výchozích scén, zařízení se přepne na scénu s minimálním 
číslem (začíná od 1 do 5). 

 

Vylepšení obrazu 

 ZAPAMATUJTE SI! 
Tato funkce se může u jednotlivých modelů lišit. Podrobnosti naleznete v aktuálním webovém rozhraní.  

 

1. Klikněte na možnost Setup > Image > Image a poté klikněte na položku Image Enhancement. 

 
2. Pomocí posuvníků změňte nastavení. Můžete také zadat hodnoty přímo. V následující tabulce jsou 

popsány některé hlavní parametry. 

Položka Popis 

Brightness 

Nastavte stupeň jasu snímků. 

  

Nízký jas Vysoký jas 
 

Saturation 

Množství odstínu obsaženého v barvě. 

  

Nízké nasycení Vysoké nasycení 
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Položka Popis 

Contrast 

Nastavte stupeň rozdílu mezi nejčernějším pixelem a nejbělejším pixelem. 

  

Nízký kontrast Vysoký kontrast 
 

Sharpness 

Kontrast ohraničení objektů v obraze. 

  

Nízká ostrost Vysoká ostrost 
 

2D Noise 
Reduction Snížení šumu ve snímcích. Funkce může způsobit rozmazání obrazu. 

3D Noise 
Reduction 

Snížení šumu ve snímcích. Funkce může vést k rozostření pohybu (nebo k zobrazení 
„duchů“ v některých aplikacích). 

Image 
Rotation 

Otočení snímku.  

  

Normální Vertikální otočení 

  

Horizontální otočení 180° 
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Položka Popis 

  

90° ve směru hodinových ručiček 90° proti směru hodinových ručiček 
 

 

3. Chcete-li obnovit výchozí nastavení v této oblasti, klikněte na položku Default. 

Expozice 

 ZAPAMATUJTE SI! 
 Tato funkce se může u jednotlivých modelů lišit. Podrobnosti naleznete v aktuálním webovém 

rozhraní. 
 Výchozí nastavení jsou adaptivní podle dané scény. Použijte výchozí nastavení, pokud jej není 

nutné změnit. 

 

1. Klikněte na možnost Setup > Image > Image a poté klikněte na položku Exposure. 
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U některých modelů kamer se stránka zobrazí následujícím způsobem. 

 

2. Nastavte požadované parametry. V následující tabulce jsou popsány některé hlavní parametry. 

Parametr Popis 

Exposure 
Mode 

Chcete-li dosáhnout požadovaného efektu expozice, vyberte správný expoziční režim. 

 Automaticky: Kamera automaticky upravuje expozici podle prostředí. 
 Vlastní: Uživatel nastaví expozici podle potřeby. 
 Vnitřní 50 Hz: Redukujte pruhy omezením času závěrky. 
 Vnitřní 60Hz: Redukujte pruhy omezením času závěrky. 
 Manuální režim: Jemně nastavte kvalitu obrazu ručním nastavením závěrky, zesílení a 

clony. 
 Nízké rozmazání pohybu: Ovládejte minimální čas závěrky, chcete-li omezit pohybové 

rozostření na tvářích zachycených v pohybu. 

Shutter (s) 

Clona slouží k ovládání světla, které přichází do objektivu. Vysoká rychlost clony je ideální 
pro rychlé pohyby scén. Pomalá rychlost clony je ideální pro scény, které se mění pomalu. 

Poznámka: 
 Rychlost závěrky lze nastavit, když je možnost Exposure Mode nastavena na hodnotu 

Manual nebo Shutter Priority.  
 Pokud je možnost Slow Shutter nastavena na hodnotu Off, vzájemná rychlost závěrky 

musí být vyšší než snímková frekvence. 

Gain (dB) 

Ovládejte obrazové signály tak, aby kamera vysílala standardní videosignály podle 
světelných podmínek. 

Poznámka:  
Tento parametr lze nastavit pouze v případě, že možnost Exposure Mode je nastavena na 
hodnotu Manual nebo Gain Priority. 

Slow Shutter 

Zlepšuje jas obrazu v podmínkách slabého osvětlení. 

Poznámka:  
Tento parametr lze nastavit pouze v případě, že položka Exposure Mode není nastavena na 
možnost Shutter Priority a když je položka Image Stabilizer deaktivována. 

Slowest 
Shutter 

Nastavte nejpomalejší rychlost závěrky, kterou kamera může použít během expozice. 

Poznámka:  
Tento parametr lze nastavit pouze v případě, že je možnost Slow Shutter nastavena na 
hodnotu On. 
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Parametr Popis 

Compensation 

Nastavte požadovanou hodnotu kompenzace, abyste dosáhli požadovaných efektů. 

Poznámka:  
Tento parametr lze nastavit pouze v případě, že možnost Exposure Mode není nastavena na 
hodnotu Manual. 

Metering 
Control 

Nastavte způsob, jakým kamera měří intenzitu světla. 

 Středově vážené průměrné měření: Měření světla převážně v centrální části snímků. 
 Vyhodnocovací měření: Měření světla v přizpůsobené oblasti snímků. 
 Zvýraznění kompenzace: Ignorujte jas přeexponované oblasti snímků. Avšak zvolením 

tohoto nastavení snížíte celkový jas snímku. 
 Měření tváře: Upravte kvalitu obrazu za špatných světelných podmínek ovládáním jasu 

zachyceného obličeje ve scéně tváře. 
Poznámka:  
Tento parametr lze nastavit pouze v případě, že možnost Exposure Mode není nastavena na 
hodnotu Manual. 

Day/Night 
Mode 

 Automaticky: Kamera zobrazuje optimální snímky podle světelných podmínek. V tomto 
režimu může kamera automaticky přepínat mezi nočním a denním režimem. 

 Noc: Kamera poskytuje vysoce kvalitní černobílé snímky pomocí stávajícího světla. 
 Den: Kamera poskytuje vysoce kvalitní barevné snímky pomocí stávajícího světla. 

Day/Night 
Sensitivity 

Prahová hodnota osvětlení pro přepínání mezi režimem Den a Noc. Vyšší citlivost znamená, 
že kamera je citlivější na změnu osvětlení a přepnutí mezi denním a nočním režimem je 
jednodušší. 

Poznámka: 
Tento parametr lze nastavit pouze v případě, že možnost Day/Night Mode je nastavena na 
hodnotu Automatic. 

Day/Night 
Switching(s) 

Nastavte dobu, než kamera přepne mezi denním a nočním režimem poté, co budou splněny 
podmínky pro přepnutí. 

Poznámka: 
Tento parametr lze nastavit pouze v případě, že možnost Day/Night Mode je nastavena na 
hodnotu Automatic. 

WDR 

Povolte funkci WDR, abyste rozlišili jasné a tmavé oblasti stejného snímku. 

Poznámka:  
Tento parametr lze nastavit pouze v případě, že možnost Exposure Mode není nastavena na 
hodnotu Customize ani Manual a když je deaktivována možnost Image Stabilizer. 

WDR Level 

Po zapnutí funkce WDR můžete zlepšit obraz úpravou úrovně WDR. 

Poznámka:  
Při vysokém kontrastu mezi jasnými a tmavými oblastmi scény použijte úroveň 7 nebo vyšší. 
V případě nízkého kontrastu se doporučuje vypnout WDR nebo použít úroveň 1-6. 

Suppress WDR 
Stripes 

Když je kamera aktivována, může kamera automaticky nastavit pomalou frekvenci závěrky 
podle frekvence světla, aby se minimalizovaly pruhy, které se mohou na snímcích 
zobrazovat. 

 

3. Chcete-li obnovit výchozí nastavení, klikněte na tlačítko Default. 

Inteligentní osvětlení 

 ZAPAMATUJTE SI! 
Tato funkce se může u jednotlivých modelů lišit. Podrobnosti naleznete v aktuálním webovém rozhraní.  
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1. Klikněte na možnost Setup > Image > Image a poté klikněte na položku Smart Illumination. 

 

2. Vyberte správný řídicí režim IR a nastavte parametry. V následující tabulce jsou popsány některé hlavní 
parametry. 

Parametr  Popis  

Lighting Type 

 Infračervené: Kamera používá osvětlení infračerveným světlem. 
 Bílé světlo: Kamera používá osvětlení bílým světlem. 
Poznámka: 
Když je možnost Control Mode nastavena na hodnotu Manual, může kamera nastavit 
úroveň osvětlení 0–1000. 

Control Mode 

 Globální režim: Kamera nastaví infračervené osvětlení a expozici pro dosažení 
vyvážených obrazových efektů. Některé oblasti mohou být přeexponovány, pokud 
vyberete tuto možnost. Tuto volbu doporučujeme, pokud jsou vaší první prioritou 
sledovaný rozsah a jas obrazu. 

 Omezení přeexponování: Kamera nastavuje infračervené osvětlení a expozici, aby se 
zabránilo regionální nadměrné expozici. Některé oblasti mohou být tmavé, pokud 
vyberete tuto možnost. Tuto volbu doporučujeme, pokud je vaší první prioritou 
přehlednost centrální části snímku a kontrola nadměrné expozice. 

 Vozovka: Tento režim poskytuje celkové silné osvětlení a doporučuje se pro sledování 
širokoúhlých scén, například vozovky. 

 Park: Tento režim poskytuje jednotné světlo a doporučuje se pro sledování scén s malým 
rozsahem s mnoha překážkami, například průmyslových parků. 

 Manuální režim: Tento režim umožňuje ruční ovládání intenzity IR osvětlení. 
 Uvnitř: Tento režim se doporučuje pro použití ve vnitřních scénách. 

Illumination 
Level 

Nastavte úroveň intenzity infračerveného světla. Čím je hodnota vyšší, tím vyšší je intenzita. 
0 znamená, že světlo IR je vypnuté. 

 Blízká úroveň osvětlení: Doporučujeme tento parametr nastavit nejprve pro širokoúhlou 
scénu. 

 Střední úroveň osvětlení: Doporučujeme nejprve nastavit tento parametr, pokud scéna 
vyžaduje střední ohniskovou vzdálenost. 

 Daleká úroveň osvětlení: Doporučuje se nejprve nastavit tento parametr, pokud scéna 
vyžaduje zobrazení teleobjektivu. 

Poznámka: 
Tento parametr lze nastavit pouze v případě, že možnost Control Mode je nastavena na 
hodnotu Manual. 

 

3. Chcete-li obnovit výchozí nastavení, klikněte na tlačítko Default. 
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Ostření  

 ZAPAMATUJTE SI! 
Tato funkce se může u jednotlivých modelů lišit. Podrobnosti naleznete u skutečných modelů.  

 

1. Klikněte na možnost Setup > Image > Image a poté klikněte na položku Focus. 

 

2. Zvolte režim ostření podle potřeby. 

Parametr Popis 

Focus Mode 

 Automatické ostření: Kamera zaostří automaticky podle aktuálních světelných 
podmínek. 

 Ruční ostření: Ručně upravte zaostření kamery podle potřeby. 
 Ostření jedním kliknutím: Kamera je aktivována tak, aby jednou zaostřila při otáčení, 

zvětšování nebo přechodem na přednastavenou pozici. 
 Ostření jedním kliknutím (IR): Při slabém osvětlení, např. v nočních hodinách nebo v 

tmavém domě, dosahuje tento režim ostření lepšího účinku při zapnutí infračerveného 
světla. 

Scene 
 Normální: Používá se pro běžné scény, například pro vozovku a průmyslový park. 
 Velká vzdálenost: Používá se pro dálkové sledování provozu na silnici. Například, když je 

kamera instalována výše než ve 30 metrech pro sledování vzdálené křižovatky. 

 

3. Chcete-li obnovit výchozí nastavení, klikněte na tlačítko Default. 

Vyvážení bílé 

Vyvážení bílé je proces kompenzace nepřirozených barevných odstínů ve snímcích s různými teplotami 
barev, aby se získaly snímky, které nejlépe vyhovují lidským očím. 

 ZAPAMATUJTE SI! 
Tato funkce se může u jednotlivých modelů lišit. Podrobnosti naleznete v aktuálním webovém rozhraní. 

 

1. Klikněte na možnost Setup > Image > Image a poté klikněte na položku White Balance. 
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2. Zvolte režim vyvážení bílé podle potřeby. V následující tabulce jsou popsány některé hlavní parametry. 

Parametr Popis 

White Balance 

Úprava červeného nebo modrého posunu obrazu: 

 Auto/Auto2: Kamera automaticky nastaví červený a modrý posun podle stavu osvětlení 
(barva má tendenci k modré). Pokud jsou snímky v automatickém režimu i nadále 
nepřirozeně červené nebo modré, zkuste možnost Auto2. 

 Jemné nastavení: Umožňuje ručně nastavit červený a modrý posun. 
 Venku: Vhodné pro venkovní prostředí s relativně větším rozsahem teploty. 
 Zámek.: Zamknout aktuální teplotu barev beze změny. 
 Sodná lampa: Kamera automaticky nastaví červený a modrý posun podle stavu osvětlení 

(barva má tendenci k červené). 

Red Offset 

Ruční úprava červeného posunu. 

Poznámka:  
Tento parametr lze nastavit pouze v případě, že možnost White Balance je nastavena na 
hodnotu Fine Tune. 

Blue Offset 

Ruční úprava modrého posunu. 

Poznámka: 
Tento parametr lze nastavit pouze v případě, že možnost White Balance je nastavena na 
hodnotu Fine Tune. 

3. Chcete-li obnovit výchozí nastavení, klikněte na tlačítko Default. 

Rozšířené 

Pomocí funkce potlačení mlhy nastavte jas snímků zachycených v podmínkách mlhy nebo oparu. 

1. Klikněte na možnost Setup > Image > Image a poté klikněte na položku Advanced. 

 

 ZAPAMATUJTE SI! 
 Tento parametr můžete nastavit pouze tehdy, když je funkce WDR vypnuta. 
 Pouze některé modely kamer podporují optické odmlžování. Pokud je možnost Defog nastavena na 

hodnotu On, intenzita potlačení mlhy 6–9 představuje optické potlačení mlhy a snímky změní 
barvu na černou/bílou, když je intenzita potlačení mlhy nastavena z úrovně 5 až 6. Pokud je 
možnost Defog nastavena na hodnotu Auto a úroveň potlačení mlhy je někde mezi 6–9, snímky se 
automaticky nezmění na černou/bílou v podmínkách lehké mlhy; kamera se automaticky přepne na 
optické potlačení mlhy pouze při těžké mlze. 

2. Povolte funkci potlačení mlhy a poté vyberte úroveň scény. Úroveň 9 dosahuje maximálního účinku 
potlačení mlhy a úroveň 1 dosahuje minima. 

  
Potlačení mlhy vypnuto Potlačení mlhy zapnuto 



25 

3. Chcete-li obnovit výchozí nastavení, klikněte na tlačítko Default. 

Typ osvětlení 

 ZAPAMATUJTE SI! 
Tato funkce se může u jednotlivých modelů lišit. Podrobnosti naleznete u aktuálního modelu.  

 

1. Klikněte na možnost Setup > Image > Image a poté klikněte na položku Smart Illumination 

 

2. V rozevírací nabídce zvolte možnost Lighting Type. 

3. Chcete-li obnovit výchozí nastavení, klikněte na tlačítko Default. 

Konfigurace režimu clony a objektivu 

 ZAPAMATUJTE SI! 
 Tato funkce je podporována pouze některými typy síťových box kamer. Podrobnosti naleznete u 

aktuálního modelu. 
 Použijte objektiv s řídicí režimem P-clona a připojte řídicí kabel clony k portu Z/F kamery. 
 Clonu lze nastavit pouze tehdy, když je možnost Lens Mode nastavena na hodnotu P-IRIS. 

 

1. Klikněte na možnost Setup > Image > Image a poté klikněte na položku Advanced. 

 

2. Upravte nastavení podle potřeby. V následující tabulce jsou popsány některé hlavní parametry. 

Parametr Popis 

Lens Mode 
 Z/F: změna zaostření a přiblížení. 
 P-Iris: změna hodnoty clony. 

Aperture 
Control 

Automaticky nebo ručně nastavte clonu. 
Poznámka:  
Tento parametr lze nastavit pouze v případě, že možnost Lens Mode je nastavena na 
hodnotu P-Iris. 

F-Number Změňte clonu ručně. 

 

3. Chcete-li obnovit výchozí nastavení, klikněte na tlačítko Default. 

Nastavení OSD 

OSD je text zobrazený na obrazovce s videosnímky a může obsahovat čas a další přizpůsobený obsah. 

 ZAPAMATUJTE SI! 
Tato funkce se může u jednotlivých modelů lišit. Podrobnosti naleznete v aktuálním webovém rozhraní. 
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1. Klikněte na možnost Setup > Image > OSD. 

 

Rozhraní OSD je u některých modelů zobrazeno následovně. 

  

2. Zvolte pozici a obsah OSD. 

 Pozice: Klikněte na požadované pole v poli Live View. Po změně tvaru kurzoru klikněte na tlačítko, 
přidržte jej a přesuňte do požadované polohy. Chcete-li přesně nastavit polohu, použijte souřadnice X 
a Y v části Overlay Area. 

 Overlay OSD Content: V rozbalovací nabídce jsou k dispozici položky Time, Preset a Serial Info. Můžete 
také vybrat možnost Custom a zadat požadovaný obsah. 

 Po nastavení polohy a obsahu OSD se symbol  zobrazí ve sloupci Status, což znamená, že OSD bylo 
úspěšně nastaveno. Pro každou oblast můžete nastavit více řádků obsahu a použít  a  k úpravě 
pořadí zobrazení. 

3. Po dokončení nastavení se zobrazí zpráva, která signalizuje úspěšné nastavení. 

V okně náhledu můžete kliknout pravým tlačítkem myši a potom zvolit zobrazení v režimu celé obrazovky 
nebo v poměru stran. Můžete také dvakrát kliknout na okno náhledu pro zobrazení nebo ukončení režimu 
celé obrazovky. 
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Chcete-li OSD pro určitou oblast zrušit, vymažte obsah ve sloupci OSD Overlay OSD Content nebo vyberte 
možnost None ve sloupci Position. 

Následující příklad zobrazuje časový údaj OSD. 

 

Privátní maskování 

Při určitých příležitostech bude případně nutné na obrazovce kamery nastavit oblast masky pro ochranu 
soukromí, například klávesnice bankomatu. Když PTZ změní svou pozici nebo provede zoom, privátní 
maska bude odpovídajícím způsobem upravena, aby byla oblast chráněna po celou dobu. 

 ZAPAMATUJTE SI! 
Tato funkce se může u jednotlivých modelů lišit. Podrobnosti naleznete v aktuálním webovém rozhraní.  

 

1. Klikněte na možnost Setup > Image > Privacy Mask. 
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U některých modelů kamery se stránka zobrazí následujícím způsobem: 

 

2. Kliknutím na možnost  přidejte privátní masku a kliknutím na tlačítko  masku odstraňte. 
 Maskování polohy: Aktivujte masku kliknutím na pole (se zobrazeným textem Mask na tomto poli). Po 

změně tvaru ukazatele myši přetáhněte pole do určené polohy. 

 Maskování oblasti: Myší nakreslete rámeček na oblast, kterou chcete maskovat. 

Když je konfigurováno privátní maskování, zamýšlená oblast se zablokuje. Následuje příklad. 

 

Konfigurace zvuku a videa 

Konfigurace videa 

Můžete nastavit parametry videa, které podporuje kamera, a zobrazit aktuální stav výstupu BNC. Jsou-li k 
dispozici, můžete také povolit sub stream a třetí stream podle potřeby. 

 

ZAPAMATUJTE SI! 
 Tato funkce se může u jednotlivých modelů lišit. Pouze některé modely kamer podporují třetí stream. 

Chcete-li zjistit, zda kamera tuto funkci podporuje, přečtěte si informace ve webovém rozhraní. 
 Po povolení sub streamu nebo třetího streamu upravte požadované parametry. Parametry pro sub stream 

a a třetí stream mají stejný význam jako pro hlavní stream. 
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1. Klikněte na možnost Setup > Video & Audio > Video. 

 

2. Upravte nastavení podle potřeby. V následující tabulce jsou popsány některé hlavní parametry. 

Parametr Popis 

Video 
Compression 

Tři možnosti: H.265, H.264 a MJPEG. 
Poznámka: 

 Kvalitu obrazu nelze nastavit, pokud je komprese videa nastavena na hodnotu H.265 
nebo H.264. Pokud je nastaveno na hodnotu MJPEG, jsou k dispozici pouze tři 
snímkové frekvence: 1, 3 a 5; a přenosová rychlost, interval snímků I, vyhlazování a 
U-kód nelze nastavit. 

 Přenosová rychlost se změní na výchozí při změně nastavení mezi H.264 a H.265. 
Výchozí přenosová rychlost pro H.265 je polovina hodnoty pro H.264. 

Frame Rate 

Snímková frekvence pro kódování snímků. Jednotka: sn./s (snímků za sekundu). 

Poznámka: 
Chcete-li zajistit určitou kvalitu obrazu, upozorňujeme, že snímková frekvence by neměla 
být vyšší než vzájemná rychlost závěrky. 

Bitrate Type 

 CBR: Konstantní přenosová rychlost, což znamená, že kamera přenáší data konstantní 
datovou rychlostí. 

 VBR: Variabilní přenosová rychlost, což znamená, že kamera dynamicky upravuje 
přenosovou rychlost podle kvality obrazu. 

Image Quality 

Pokud je možnost Encoding Mode nastavena na hodnotu VBR, můžete posunutím 
posuvníku nastavit úroveň kvality snímků. Posunutím posuvníku k možnosti Bit Rate se 
snižuje přenosová rychlost a může být ovlivněna kvalita obrazu. Posunutím posuvníku 
k možnosti Quality se zvyšuje přenosová rychlost a může být zlepšena kvalita obrazu. 
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Parametr Popis 

I Frame Interval Interval, ve kterém je kódován snímek I. Zkrácený interval snímků I nabízí obvykle lepší 
kvalitu obrazu, ale spotřebovává se větší šířka pásma. 

GOP Skupina snímků v kódování videa MPEG. Tento parametr určuje pořadí, ve kterém jsou 
uspořádány vnitřní snímky (snímky I) a mezisnímky. 

SVC SVC (škálovatelné kódování videa) může snížit úložiště bez ohrožení kvality přehrávání. 

U-Code 

 Základní režim: Aktuální přenosová rychlost je přibližně 3/4 nastavené přenosové 
rychlosti. 

 Pokročilý režim: Aktuální přenosová rychlost je přibližně 1/2 nastavené přenosové 
rychlosti. 

Poznámka: 
 Je-li povolena možnost U-Code, komprese videa podporuje pouze standardy H.264 a 

H.265. MJPEG není podporováno. 
 Je-li povolena možnost U-Code, režim snímání nepodporuje snímkové frekvence vyšší 

než 30. 

Smoothing 

Nastavte rozsah vyhlazování. Vyberete-li možnost Clear, znamená to deaktivaci volby 
Smoothing. Přesunutím posuvníku směrem k možnosti Smooth se zvyšuje úroveň 
vyhlazování, ale je ovlivněna kvalita obrazu. 

Poznámka:  
Ve špatném síťovém prostředí můžete povolit vyhlazování, abyste získali plynulejší video. 

BNC Output Výstup BNC podporuje NTSC a PAL. 

 

3. Klikněte na možnost Save. 

Konfigurace zvuku 

Konfigurace zvuku znamená nastavení parametrů kódování zvuku pro kameru. 

 

ZAPAMATUJTE SI! 
Tato funkce není u některých modelů podporována. Podrobnosti naleznete u aktuálního modelu. 

 

1. Klikněte na možnost Setup > Video & Audio > Audio. 
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2. Upravte nastavení podle potřeby. V následující tabulce jsou popsány některé hlavní parametry. 

Parametr Popis 

Audio Input 

Při výběru položky Off nebudou kódovány žádná zvuková data. 

Poznámka:  
Pokud nepotřebujete zvuk, doporučuje se vybrat možnost Off. To může do jisté míry zlepšit 
výkon zařízení. 

Access Mode 

Aktuálně pouze možnost Line/Mic. 

Poznámka:  

Tato funkce není dostupná pro zařízení se dvěma kanály audiovýstupu. 

Audio 
Compression 

Tři možnosti: G.711U, G.711A a ACC-LC.  

G.711U a G.711A podporují pouze vzorkovací frekvenci 8K a ACC-LC podporuje vzorkovací 
frekvence 8K, 16K a 48K. 

Input Gain Zesilování zvukových signálů pro vzorkování. Čím vyšší je zisk, tím větší je zesílení. 

Noise 
Suppression 

Používá se ke snížení šumu ve snímcích. Chcete-li povolit potlačení šumu, vyberte možnost 
On. 

Channel 

Kanál audio výstupu. Chcete-li aktivovat výstup zvuku, vyberte možnost Enable. 

Poznámka:  

Pouze některé modely kamer podporují dva kanály. 

 

3. Klikněte na možnost Save. 

Snímek 

1. Klikněte na možnost Setup > Video & Audio > Snapshot. 

 
2. Vyberte možnost On a poté podle potřeby nastavte rozlišení, kvalitu obrazu a harmonogram. 

3. Klikněte na možnost Save. 

ROI 

Pokud je zapnuta oblast zájmu (ROI), systém zajistí nejprve kvalitu obrazu ROI, pokud je přenosová rychlost 
nedostatečná. 

 

ZAPAMATUJTE SI! 
Tato funkce není u některých modelů podporována. Podrobnosti naleznete u aktuálního modelu. 
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1. Klikněte na možnost Setup > Video & Audio > ROI. 

 

2. Klikněte na možnost  a poté přetáhněte myš k pokrytí zamýšlených částí obrazu. Chcete-li oblast 

odstranit, vyberte danou oblast a klepněte na tlačítko . 

Konfigurace datového proudu médií 

Stream médií 

Můžete zobrazit standardní datové proudy médií z kamery. Můžete také nastavit kameru tak, aby přenášela 
kódové streamy protokolem UDP nebo TCP na zadanou adresu IP a číslo portu. Nastavení lze uložit, přičemž 
se takové nastavení projeví po restartování kamery. 

 

ZAPAMATUJTE SI! 
 Tato funkce není u některých modelů podporována. Podrobnosti naleznete u aktuálního modelu. 
 Výběr transportního protokolu na základě vašich skutečných potřeb a výkonu sítě. Obecně řečeno, 

TCP umožňuje lepší kvalitu obrazu než UDP, ale také způsobuje vyšší latenci. 

1. Klikněte na možnost Setup > Video & Audio > Media Stream. 

 

2. Klikněte na možnost , vyberte typ streamu a poté nastavte adresu IP a číslo portu skupiny unicast 

nebo vícesměrového vysílání pro dekódovací zařízení, které přijímá z kamery audio a video streamy. 

Chcete-li, aby zařízení nastavilo datový proud médií, který byl po restartování automaticky 
konfigurován, vyberte možnost Yes na Persistent. 
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3. Chcete-li stream odstranit, klikněte na . 
4. Dokončete operaci kliknutím na Submit. 

RTSP Multicast adresa  

Po nakonfigurování RTSP Multicast adresy si může přehrávač jiného výrobce vyžádat RTSP Multicast datový 
proud médií z kamery prostřednictvím protokolu RTP. 

1. Klikněte na možnost Setup > Video & Audio > Media Stream > RTSP Multicast Address. 

 
U některých modelů kamer se stránka zobrazí následujícím způsobem. 
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2. Nastavte adresu vícesměrového vysílání (224.0.0.0 na 239.255.255.255) a číslo portu (0 až 65535). 

3. Klikněte na možnost Save. 

Inteligentní konfigurace alarmu 

Můžete nastavit inteligentní sledování pro počítání osob a sledování pohybujících se objektů. Inteligentní 
sledování zahrnuje počítání osob, detekci vniknutí a automatické sledování. 

Podporované funkce se mohou lišit podle modelu kamery. 

Inteligentní nastavení 

Klikněte na možnost Setup > Intelligent > Smart Settings. 

 
U některých modelů kamer se stránka zobrazí následujícím způsobem. 
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Detekce překročení linie 

Detekce křížové linie detekuje objekty, které překročí virtuální linii v živém videu a spustí poplach při zjištění 
takové události. 

1. Klikněte na možnost Setup > Intelligent > Smart Settings. Vyberte možnost  Cross Line a poté klikněte 

na . 

 

 

2. Vyberte možnost Cross Line Detection. 

3. V oblasti Detection Rule klikněte na možnost  a přidejte novou oblast detekce. Chcete-li odstranit 

oblast detekce, klepněte na tlačítko . 
4. V malém podokně náhledu přetáhněte linku do určené polohy a nastavte rozsah detekce. 

5. Nastavte směr a citlivost kamery – tím nastavíte, zda chcete hlásit alarm detekce překročení linie. 

6. Nastavte akce aktivace alarmu a plán aktivace podle potřeby. Podrobné kroky naleznete v popisu akcí 
vyvolaných alarmem v části Konfigurace alarmu detekce pohybu. 

7. Klikněte na možnost Save. 

Detekce vniknutí 

Detekce vniknutí detekuje objekty, které vstupují do zadané oblasti v živém videu a spustí alarm při zjištění 
takové události. 
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1. Klikněte na možnost Setup > Intelligent > Smart Settings. Vyberte možnost  Intrusion a poté klepněte 

na tlačítko . 

 

2. Vyberte možnost Intrusion Detection. 

3. V oblasti Detection Rule klikněte na možnost  a přidejte novou oblast detekce. Chcete-li odstranit 

oblast detekce, klepněte na tlačítko . 
4. Přetáhněte rámečky pole a nastavte požadovanou pozici a rozsah. 

5. Nastavte prahovou hodnotu času, citlivost a procento, aby kamera rozhodla, zda má hlásit alarm 
detekce vniknutí. 

 Time Threshold: Minimální doba trvání, po kterou musí narušitel zůstat v detekční oblasti před 
hlášením alarmu. 

 Sensitivity: Citlivost detekce. Vyšší hodnota znamená vyšší citlivost detekce. 

 Percentage: Zaznamená se minimální poměr velikosti narušitele k velikosti určené detekční oblasti 
před nahlášením alarmu. 

6. Nastavte akce aktivace alarmu a plán aktivace podle potřeby. Podrobné kroky naleznete v popisu akcí 
vyvolaných alarmem v části Konfigurace alarmu detekce pohybu. 

7. Klikněte na možnost Save. 

Detekce obličeje 

Detekce obličeje detekuje lidské tváře v živém videu. 
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1. Klikněte na možnost Setup > Intelligent > Smart Settings. Vyberte možnost  Face a poté klikněte na 

. 

 
2. Přetáhněte rámečky a nastavte požadovanou pozici a rozsah. 

3. Nastavte parametry detekce podle aktuálních potřeb. 

4. Nastavte akce aktivace alarmu a plán aktivace podle potřeby. Podrobné kroky naleznete v popisu akcí 
vyvolaných alarmem v části Konfigurace alarmu detekce pohybu. 

5. Klikněte na možnost Save. 

6. Klikněte na možnost Start Intelligent Analysis. 

Počítání osob 

 

ZAPAMATUJTE SI! 
 Tuto funkci podporují pouze některé modely kamery. 
 Podporovaný režim spouštění a zapnutí alarmu se může v závislosti na modelu kamery lišit. 

Podrobnosti naleznete v aktuálním webovém rozhraní. 
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1. Klikněte na možnost Setup > Intelligent > Smart Settings. Vyberte možnost  People Counting a poté 

klikněte na . 

 
2. Vyberte možnost Enable Passenger Flow Detection. Vyberte režim detekce, nastavte interval hlášení a 

citlivost. 

3. Klikněte na možnost Draw Detection Area a poté nakreslete detekční oblast v okně náhledu vlevo, 
např. čtverec. 

4. Klikněte na možnost Draw Entrance Direction a pak nakreslete směr v okně náhledu vlevo. Směr je 
obvykle svislý nebo nakloněný. 

5. Nastavte možnost Max. Size a Min. Size v části Filter by Object Size. Pouze objekty v rozmezí dané 
velikosti budou počítány; jiné budou odfiltrovány a nebudou započítány. 

6. Nastavte akce aktivace alarmu a plán aktivace podle potřeby. Podrobné kroky naleznete v popisu akcí 
vyvolaných alarmem v části Konfigurace alarmu detekce pohybu. 

7. Chcete-li obnovit výsledky počítání, klepněte na tlačítko Clear Counting Result. 

8. Klikněte na možnost Save. 

Automatické sledování 

Kamera automaticky sleduje objekt, který aktivuje dané pravidlo. 

 

ZAPAMATUJTE SI! 
 Tuto funkci podporují pouze některé modely kamery. 
 Podporovaný režim spouštění a zapnutí alarmu se může v závislosti na modelu kamery lišit. 

Podrobnosti naleznete v aktuálním webovém rozhraní. 
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1. Klikněte na možnost Setup > Intelligent > Smart Settings. Vyberte možnost Auto Tracking a poté 

klikněte na . 

 

2. Nastavte časový limit sledování (jednotka: sec) a poměr přiblížení. 

3. Klikněte na možnost Save. 

Detekce rozostření 

 

ZAPAMATUJTE SI! 
 Tuto funkci podporují pouze některé modely kamery. 
 Podporovaný režim spouštění a zapnutí alarmu se může v závislosti na modelu kamery lišit. 

Podrobnosti naleznete v aktuálním webovém rozhraní. 

 

Použijte detekci rozostření, abyste detekovali rozostření kamery a nahlásili alarm při zjištění takové události. 

1. Klikněte na možnost Setup > Intelligent > Smart Settings. Vyberte možnost Defocus a poté klikněte na 

. 

 

2. Vyberte možnost Defocus Detection. 

3. Nastavte citlivost detekce a akce vyvolané alarmem podle potřeby. Podrobné kroky naleznete v popisu 
akcí vyvolaných alarmem v části Konfigurace alarmu detekce pohybu. 

4. Klikněte na možnost Save. 
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Detekce změny scény 

 

ZAPAMATUJTE SI! 
 Tuto funkci podporují pouze některé modely kamery. 
 Podporovaný režim spouštění a zapnutí alarmu se může v závislosti na modelu kamery lišit. 

Podrobnosti naleznete v aktuálním webovém rozhraní. 

 

Použijte detekci změny scény, abyste detekovali změnu monitorovacího prostředí způsobenou vnějšími 
faktory, jako je úmyslné otáčení kamery, a nahlásili alarm při zjištění takové události. 

1. Klikněte na možnost Setup > Intelligent > Smart Settings. Vyberte možnost Scene Change a poté 

klikněte na . 

 
2. Vyberte možnost Scene Change Detection. 

3. Nastavte citlivost detekce. Nastavte akce aktivace alarmu a plán aktivace podle potřeby. Podrobné 
kroky naleznete v popisu akcí vyvolaných alarmem v části Konfigurace alarmu detekce pohybu. 

4. Klikněte na možnost Save. 

Rozšířená nastavení 

Pokročilá nastavení zahrnují jasnost snímků a režim detekce pro inteligentní funkce. 

Parametry fotografie 

Nastavte jasnost snímků. 
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1. Klikněte na možnost Setup > Intelligent > Advanced Settings. Klikněte na kartu Photo parameters . 

 
2. Nastavte původní obraz a jasnost miniatury. 

3. Klikněte na možnost Save. 

 

ZAPAMATUJTE SI! 
Před nastavením parametru fotografie vypněte detekci tváře. 

 

Parametry detekce 

 

ZAPAMATUJTE SI! 
 Pouze některé modely kamer podporují pokročilé nastavení. Podrobnosti naleznete v aktuálním 

webovém rozhraní. 
 Výchozí režim detekce je Normal Mode. Nastavte podle potřeby. 

 

1. Klikněte na možnost Setup > Intelligent > Advanced Settings. Klikněte na kartu Detection parameters. 

 

2. Vyberte režim detekce. Vyberte možnost Filter Repeated Motion Mode, aby se zabránilo 
opakovanému hlášení alarmů způsobenému opakovaným pohybem zjištěným ve sledovaném 
prostředí. 

3. Klikněte na možnost Save. 

Společná konfigurace alarmu 

Můžete naplánovat oznamování alarmů a nastavit akce, které mohou být spuštěny jinými zařízeními, takže 
alarmy a spouštěné akce mohou být včas zpracovány. 

Hlášení alarmů lze naplánovat na alarm detekce pohybu, alarmový vstup, alarmový výstup, alarm detekce 
neoprávněné manipulace a alarm audio detekce. Podporované alarmy se mohou lišit podle modelu 
zařízení. Typy alarmů, které vaše kamera podporuje, naleznete na webovém rozhraní. 

Konfigurace alarmu detekce pohybu 

Detekce pohybu detekuje pohyb objektu v určené obdélníkové oblasti během určité doby. Je nutné nastavit 
detekční oblast, citlivost detekce, velikost objektu a historii, aby se kamera rozhodla, zda nahlásí detekci 
pohybu při detekci pohybu. 

 

ZAPAMATUJTE SI! 
 Tato funkce není u některých modelů podporována. Podrobnosti naleznete u aktuálního modelu. 
 Aktivace akcí alarmu se mohou u jednotlivých modelů lišit. Podrobnosti naleznete v aktuálním webovém 

rozhraní. 
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Oblast detekce 

1. Klikněte na možnost Setup > Events > Common Alarm > Motion Detection. Nastavte možnost 
Detection Mode na Area. 

 

2. V oblasti Detection Area klikněte na možnost  a přidejte novou detekční oblast. Chcete-li odstranit 

oblast detekce, klepněte na tlačítko . 
3. Klepnutím a přetažením myši nastavte detekční oblast. 

4. Nastavte citlivost detekce, velikost objektu a historii, aby se kamera rozhodla, zda má hlásit alarm 
detekce pohybu. 

 Posunutím posuvníku doprava se zvyšuje citlivost detekce. Pokud rozsah pohybu uvnitř detekční 
oblasti překročí nastavenou velikost objektu a trvání pohybu překročí nastavenou dobu, kamera ohlásí 
alarm. 

 Velikost objektu určuje minimální poměr velikosti objektu k velikosti celkové detekční oblasti před 
nahlášením alarmu. To znamená, že k detekci pohybu malých objektů je třeba nakreslit malé pole 
(detekční oblast) v aktuální oblasti pohybu. 

 Výsledky detekce pohybu jsou zobrazeny v reálném čase. Červené čáry představují vyvolané alarmy 
detekce pohybu. Čím delší je čára, tím větší je rozsah pohybu. Čím hustší čáry, tím větší je frekvence 
pohybu. 
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5. Nastavte parametry alarmu. 

 Potlačte alarm(y): Po spuštění alarmu nebude stejný alarm hlášen v nastaveném čase. 

 Smazat alarm(y): Po spuštění alarmu, 

a. Není-li stejný alarm spuštěn v nastaveném čase, alarm se vymaže a stejný alarm se může nahlásit 
znovu. 

b. Je-li stejný alarm spuštěn v nastaveném čase, alarm nebude vymazán, dokud nevyprší čas vypršení 
alarmu. Pak může být opět hlášen stejný alarm. 

6. Nastavte akce, které mají být vyvolány alarmem detekcí pohybu a plánem. 

 

Následující tabulka popisuje hlavní události vyvolané alarmy a způsob nastavení plánu. 

Položka Popis 

Alarm 
Output 1 

Zaškrtněte políčko. Toto nastavení je rozhraní alarmového výstupu spojené s alarmem detekce 
pohybu. 

Poznámka:  
Když je nahlášen alarm, kamera vyvolá alarmový výstup tak, aby spustil akce zařízení třetí strany. 

Goto 
Preset 

Vyberte zaškrtávací políčko a nastavte přednastavenou pozici na detekci pohybu. 

Poznámka: 
 Ujistěte se, že jste nastavili přednastavené pozice. V opačném případě nelze tento parametr 

nastavit. Podrobné informace o nastavení přednastavené pozice naleznete v tématu 
Nastavení přednastavených pozic 

 Když je ohlášen alarm, kamera PTZ automaticky přejde do přednastavené pozice pro 
zachycení videa ve správné scéně. 

Upload to 
FTP 

Je-li vybrána možnost Upload to FTP kamera automaticky odešle snímky na daný server FTP při 
spuštění alarmu. 

Poznámka: 
Před použitím této funkce se ujistěte, že jste dokončili FTP a Snímek. 

Recording 

Je-li vybrána možnost Recording, kamera automaticky zaznamená video při spuštění alarmu. 

Poznámka: 

Nejdříve nastavte možnost Post-Record(s) na stránce Storage. Možnost Post-Record(s) určuje, 
jak dlouho nahrávání pokračuje po ukončení alarmu. 

Alarm the 
Center 

Je-li vybrána možnost Alarm the Center kamera vysílá informace o alarmu na centrální server při 
spuštění alarmu. 

Poznámka: 

Nejdříve vyplňte nastavení na stránce Server. 

Trigger 
Tracking 

Je-li vybrána možnost Trigger Tracking kamera spustí automatické sledování při spuštění alarmu. 

Poznámka: 

Tuto funkci podporují pouze některé modely kamery. 

Nejdříve nastavte automatické sledování na stránce Smart Settings. 

Trigger 
E-mail 

Je-li vybrána možnost Trigger E-mail kamera po odeslání poplachu automaticky odešle snímky 
na zadanou e-mailovou adresu. 

Poznámka: 
Před použitím této funkce se ujistěte, že jste dokončili E-mail. 
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Enable Plan 

Vyberte zaškrtávací políčko a nastavte počáteční a koncové časy, během kterých je účinný alarm 
detekce pohybu. Můžete přímo přetáhnout myší a nakreslit plán a kliknout na Edit pro úpravu 
časového období v tabulce. Časová období se nemohou překrývat. Kamera hlásí alarmy pouze 
během určeného období. 

Můžete si vybrat od pondělí do neděle a nastavit čtyři období pro každý den. 

 

 

Přetažením myši nakreslete plán  Upravte časová období v tabulce 

Poznámka:  
Na kreslení plánu myší je podporováno pouze ve verzích IE novějších než 8.0. Po nastavení plánu 
na jeden den můžete použít stejné nastavení na další dny kliknutím na Copy a Paste. 

 

7. Klikněte na možnost Save. 

Mřížka detekce 

1. Klikněte na možnost Setup > Events > Motion Detection. Nastavte možnost Detection Mode na Grid. 

 
2. Detekční oblast může být na mřížce nepravidelná. 

3. Nastavte citlivost detekce, aby se kamera rozhodla, zda má hlásit alarm detekce pohybu (alarm 
viditelný na kompatibilním NVR). 

4. Nastavte parametry alarmu. 

 Suppress Alarm(s): Po spuštění alarmu nebude stejný alarm hlášen v nastaveném čase. 

 Clear Alarm(s): Po spuštění alarmu, 

a. Není-li stejný alarm spuštěn v nastaveném čase, alarm se vymaže a stejný alarm se může nahlásit 
znovu. 

b. Je-li stejný alarm spuštěn v nastaveném čase, alarm nebude vymazán, dokud nevyprší čas vypršení 
alarmu. Pak může být opět hlášen stejný alarm. 
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5. Nastavte akce, které mají být vyvolány alarmem detekcí pohybu a plánem. Podrobné kroky naleznete 
v popisu akcí vyvolaných alarmem v části Oblast detekce v Konfigurace alarmu detekce pohybu. 

6. Klikněte na možnost Save. 

Konfigurace alarmu neoprávněné manipulace 

Konfigurujte alarm neoprávněné manipulace tak, aby kamera hlásila alarm neoprávněné manipulace, když 
je objektiv po určitou dobu zablokován. 

 

ZAPAMATUJTE SI! 
 Tato funkce není u některých modelů podporována. Podrobnosti naleznete u aktuálního modelu. 
 Aktivace akcí alarmu se mohou u jednotlivých modelů lišit. Podrobnosti naleznete v aktuálním webovém 

rozhraní. 

 

1. Klikněte na možnost Setup > Events > Common Alarm >Tampering Alarm. 

 

2. Vyberte možnost On pro Tampering Alarm. 

3. Nastavte citlivost detekce a dobu, po které se kamera rozhodne, zda má ohlásit alarm neoprávněné 
manipulace. 

Citlivost je rozdělena do tří úrovní: vysoká, střední a nízká. Ve srovnání se střední citlivostí může 
kamera detekovat blokování ze vzdálenějšího místa, když je citlivost nastavena na vysokou. Kamera 
hlásí poplach, když je objektiv zablokován po určitou dobu. 

Alarm neoprávněné manipulace je účinný na celé obrazovce. Chcete-li deaktivovat alarm neoprávněné 
manipulace, zrušte zaškrtnutí políčka Tampering Alarm. 

4. Nastavte akce, které mají být aktivovány alarmem neoprávněné manipulace a plánem. Podrobné 
kroky naleznete v popisu akcí vyvolaných alarmem v části Konfigurace alarmu detekce pohybu. 

5. Klikněte na možnost Save. 

Konfigurace alarmu audio detekce 

Kamera dokáže detekovat vstupní audio signály pro výjimky. Když vzestup nebo pokles hlasitosti překročí 
nastavený limit nebo když vstupní hlasitost dosáhne prahu, kamera hlásí alarm a spustí nastavené akce. 
Ujistěte se, že zařízení audio vstupu je správně připojeno k kameře a audio vstup je zapnutý v Konfigurace 
alarmového vstupu. 
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ZAPAMATUJTE SI! 
 Tato funkce není u některých modelů podporována. Podrobnosti naleznete v aktuálním webovém 

rozhraní. 
 Aktivace akcí alarmu se mohou u jednotlivých modelů lišit. Podrobnosti naleznete v aktuálním webovém 

rozhraní. 

 

1. Klikněte na možnost Setup > Events > Common Alarm >Audio Detection. 

 
2. Vyberte možnost Enable pro Audio Detection, vyberte typ detekce a nastavte rozdíl nebo prahovou 

hodnotu. Chcete-li zakázat audio detekci, zrušte zaškrtnutí políčka Enable. 

V následující tabulce jsou popsány některé hlavní parametry. 

Parametr Popis 

Detection 
Type 

 Náhlý růst: Alarm je nahlášen, když nárůst hlasitosti překročí daný rozdíl. 
 Náhlý pokles: Alarm je nahlášen, když pokles hlasitosti překročí daný rozdíl. 
 Náhlá změna: Alarm je nahlášen, když nárůst či pokles hlasitosti překročí daný rozdíl. 
 Prahová hodnota: Alarm je nahlášen, když hlasitost překročí prahovou hodnotu. 

Difference 

 Prahová hodnota: Po nastavení určité hlasitosti jako prahové hodnoty se po překročení 
prahové hodnoty ozve alarm. 

 Rozdíl: rozdíl mezi dvěma hlasitostmi. Pokud nárůst nebo pokles hlasitosti překročí daný 
rozdíl, je hlášen alarm. 

Poznámka: 
 Měřítko v oblasti audio detekce se používá k měření hlasitosti zvuku. 
 Výsledky audio detekce jsou zobrazeny v reálném čase. Červená část označuje hlášené 

alarmy audio detekce. 
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Parametr Popis 

 

 

 

3. Nastavte akce aktivace alarmu a plán aktivace podle potřeby. Podrobné kroky naleznete v popisu akcí 
vyvolaných alarmem v části Konfigurace alarmu detekce pohybu. 

4. Klikněte na možnost Save. 

Konfigurace alarmového vstupu 

Kamera může přijímat informace o alarmu ze zařízení třetí strany. Chcete-li tuto funkci používat, je nutné 
nejprve nakonfigurovat následující informace pro alarmový vstup: port, název poplachu, typ alarmu 
(normálně otevřený nebo normálně zavřený) a čas hlášení alarmů. 

 

ZAPAMATUJTE SI!  
 Tato funkce není u některých modelů podporována. Podrobnosti naleznete u aktuálního modelu. 
 Aktivace akcí alarmu se mohou u jednotlivých modelů lišit. Podrobnosti naleznete v aktuálním webovém 

rozhraní. 
  

ScaleVolume

Difference

Měřítko Hlasitost 

Rozdíl 
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1. Klikněte na možnost Setup > Events > Common Alarm > Alarm Input. 

 

2. Vyberte alarm a nastavte název alarmu. 

3. Vyberte možnost N.O. nebo N.C. v závislosti na typu zařízení alarmového vstupu třetí strany. Pokud je 
například zařízení alarmového vstupu třetí strany normálně otevřeno, je nutné zde zvolit N.O., aby 
kamera mohla přijímat informace ze zařízení alarmového vstupu třetí strany. 

4. Nastavte akce, které mají být spuštěny alarmovým vstupem a plánem. Podrobné kroky naleznete v 
popisu akcí vyvolaných alarmem v části Konfigurace alarmu detekce pohybu. 

5. Klikněte na možnost Save. 

Konfigurace alarmového výstupu 

Po aktivaci alarmového výstupu alarmem detekce pohybu, booleovským poplachem, může kamera vysílat 
informace o poplachu do zařízení třetí strany, pokud je alarmový výstup správně nastaven na normálně 
otevřen nebo normálně zavřen. Trvání alarmového výstupu je konfigurovatelné. 

 

ZAPAMATUJTE SI! 
Tato funkce není u některých modelů podporována. Podrobnosti naleznete u aktuálního modelu. 
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1. Klikněte na možnost Setup > Events > Common Alarm > Alarm Output.  

 
2. Vyberte alarm a nastavte název alarmu. 

3. Nastavte stav na N.O. (výchozí nastavení) a nastavte dobu trvání alarmu. 

4. Nastavte akce, které mají být spuštěny alarmovým vstupem a plánem. Podrobné kroky naleznete v 
popisu akcí vyvolaných alarmem v části Konfigurace alarmu detekce pohybu. 

5. Klikněte na možnost Save. 

 

UPOZORNĚNÍ! 
Při zapínání zařízení striktně dodržte pořadí, aby nedošlo k poškození součástí kamery:  
1. Zkontrolujte, zda je typ alarmu nastaven na Normally Open (výchozí nastavení) a zařízení alarmového 

výstupu jsou vypnuta.  
2. Po dokončení připojení nejprve zapněte kameru a poté zapněte zařízení alarmového výstupu. 

 

Úložiště – paměťová karty 

 ZAPAMATUJTE SI! 
 Tato funkce není podporována u některých modelů a může se lišit podle modelů. Podrobnosti 

naleznete u aktuálního modelu. 
 Úložiště v zařízení je doporučeno, když kamera pracuje v samostatném režimu. Pokud je kamera 

spravována centrálním serverem pro správu, je třeba zastavit úložiště v zařízení, aby nedošlo k 
ovlivnění služby následného záznamu v mezipaměti. 

 

Nastavení úložiště v zařízení 

Úložiště v zařízení slouží k ukládání dat videa a snímků přímo na paměťovou kartu. Úložiště v zařízení je 
doporučeno, když kamera běží v samostatném režimu. 

Manuální ukládání 

Kamera zaznamenává živé video opakovaně, pokud je povoleno manuální ukládání. 
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1. Klikněte na možnost Setup > Storage > Storage. 

 
U některých modelů kamer se stránka zobrazí následujícím způsobem. 

 

2. Spusťte úložiště v zařízení a upravte nastavení podle potřeby. V následující tabulce jsou popsány 
některé hlavní parametry. 

Parametr Popis 

Storage 
Medium 

Typ zdroje úložiště. 

Poznámka: 
 Chcete-li naformátovat paměťovou kartu, nejprve deaktivujte funkci ukládání na kartu. 

Poté klikněte na možnost Format a poté na OK pro potvrzení operace. Po dokončení 
formátování se systém restartuje. 

 Zobrazí se informace o celkovém a volném prostoru. 

Data 
Overwrite 
Policy 

 Přepsat: Pokud na paměťové kartě není volné místo, nová data budou opakovaně 
přepisovat stávající data. 

 Zastavení: Pokud na paměťové kartě není volné místo, nová data nebudou na 
paměťovou kartu uložena. 

Post-Record(s) Pro nahrávání vyvolané alarmem – doba trvání záznamu po ukončení alarmu. 

 

3. Klikněte na možnost Save. 
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Záznam dle plánu 

Je-li zapnutý záznam dle plánu, kamera zaznamená video na paměťovou kartu během stanovených 
časových úseků. 

1. Klikněte na možnost Setup > Storage > Storage. 
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U některých modelů kamer se stránka zobrazí následujícím způsobem. 

 

2. Vyberte možnost Planned Storage a poté nastavte dobu, po kterou kamera zaznamená video na 
paměťovou kartu. 

3. Klikněte na možnost Save. 

 ZAPAMATUJTE SI!  
 Záznam dle plánu není účinný, pokud jsou povoleny zároveň manuální úložiště a záznam dle plánu. 
 Chcete-li vyhledat záznamy na paměťové kartě, viz Přehrávání videa a stahování pomocí úložiště v 

zařízení. 

 

Nastavení následného záznamu v mezipaměti. 

Kamera v centralizované správě může používat paměťovou kartu jako záložní zdroj úložiště centrálního 
serveru pro správu. Pokud je ukládání z kamery do centrálního úložného zařízení přerušeno kvůli 
nestabilnímu síťovému připojení, kamera automaticky spustí následný záznam v mezipaměti po nahrání a 
uložení videozáznamů na paměťovou kartu. 

Pokud je povoleno zálohování záznamu, může kamera automaticky přenést video uložené na paměťové 
kartě na paměťové médium záložního serveru ve formě souboru při obnovení komunikace mezi kamerou a 
záložním serverem. 
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 ZAPAMATUJTE SI! 
Před nastavením následného záznamu v mezipaměti pro kameru zkontrolujte, zda: 

 Paměťová karta je správně nainstalována v kameře. 
 Zálohovací prostředek byl přidán k centrálnímu serveru. 
 Pro kameru byl přidán záložní zdroj. 

 

Zakázat úložiště v zařízení 

1. Klikněte na možnost Setup > Storage > Storage. 

 

U některých modelů kamer se stránka zobrazí následujícím způsobem. 

 

2. Nastavte možnost Edge Storage na Disable (čímž deaktivujete manuální) a nastavte kapacitu videa. 

3. Klikněte na možnost Save. 

Údržba systému 

 ZAPAMATUJTE SI!  
Tato funkce není u některých modelů podporována. Podrobnosti naleznete u aktuálního modelu. 
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Zabezpečení 

Správa uživatelů 

V systému jsou dva typy uživatelů: 

 Správce: v této příručce se označuje jako „admin“. Výchozí jméno správce je admin, který nelze 
změnit. Správce má úplná oprávnění a může spravovat všechny uživatele a zařízení. V systému je 
povolen pouze jeden správce. 

 Běžný uživatel: v této příručce je označován jako „uživatel“. Uživatel má pouze povolení přehrávat živé 
a zaznamenané video. V systému je povoleno až 32 běžných uživatelů. 

V rozhraní pro správu uživatele můžete přidat uživatele (v části Setup > Security > User). 

Po úspěšném přidání uživatele můžete změnit heslo zadáním nového hesla nebo vymazat uživatele 
odstraněním uživatelského jména. 

 ZAPAMATUJTE SI! 
 Pouze správce může změnit hesla. Změna uživatelského jména nebo hesla pro uživatele, pokud je 

uživatel ještě přihlášen, vynutí odhlášení uživatele. Uživatel se musí přihlásit pomocí nového 
uživatelského jména nebo hesla. 

 Pouze správce může přidávat a odstraňovat uživatele. Odstranění uživatele, pokud je uživatel ještě 
přihlášen, vynutí odhlášení uživatele. Odstraněný uživatel se nemůže přihlásit. 

 

Nastavení bezpečného přenosu dat 

Nastavte bezpečný kanál pro přenos dat, abyste zajistili bezpečnost. 

 ZAPAMATUJTE SI!  
Tato funkce není u některých modelů podporována. Podrobnosti naleznete u aktuálního modelu. 

 

1. Klikněte na možnost Setup > Network > Port. 

 
2. Zadejte číslo portu v textovém poli  HTTPS Port. 

3. Klikněte na tlačítko Save. 

4. Klikněte na možnost Setup > Security > Network Security > HTTPS. 

 

5. Vyberte možnost On pro HTTPS. Můžete podle potřeby importovat vlastní certifikát SSL. 

6. Klikněte na možnost Save. 

Při příštím přihlášení zadejte adresu ve formátu https://IP:HTTPS číslo portu, například 
https://192.168.0.13:443 pro vstup do režimu zabezpečeného kanálu. Pokud používáte  
výchozí port HTTPS, zadejte https://IP. 

Ověřování  

RTSP (Real Time Streaming Protocol) je protokol aplikační vrstvy. Chcete-li odeslat a ovládat audio a video, 
nastavte ověření pomocí protokolu RTSP ve webovém rozhraní. 
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1. Klikněte na možnost Setup > Security > Network Security > Authentication. 

 
2. Vyberte režim ověřování a klepněte na tlačítko Save. 

Skrýt informace o dodavateli 

Ve webovém rozhraní můžete nastavit skrytí informací o dodavateli síťové kamery. 

1. Klikněte na možnost Setup > Security > Registration Info. 

 
2. V části Registration Info vyberte položku On. 

3. Klikněte na možnost Save. 

Vazba APR 

Tato funkce chrání kameru před útoky ARP. Brána a adresa MAC musí být nastaveny správně, než může 
počítač přistupovat ke kameře z jiné sítě; pokud je nastavena nesprávná adresa MAC, mohou mít přístup 
pouze počítače ve stejné síti LAN. 

1. Klikněte na možnost Setup > Security > Network Security > ARP Protection. 

 

2. Zaškrtnutím políčka povolíte funkci vazby ARP a nastavíte adresu brány MAC. 

3. Klikněte na možnost Save. 

Filtrování IP adres 

Použijte filtrování IP adres pro povolení nebo zakázání přístupu ze zadané adresy IP. 

 ZAPAMATUJTE SI!  
Tato funkce není u některých modelů podporována. Podrobnosti naleznete u aktuálního modelu. 

 

1. Klikněte na možnost Setup > Security > Network Security > IP Address Filtering. 
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2. Vyberte možnost On a povolte filtrování IP adres 

3. Vyberte režim filtrování a přidejte IP adresu (adresy). 

4. Klikněte na možnost Save. 

 ZAPAMATUJTE SI! 
 Pokud je možnost Filtering Mode nastavena na Whitelist, pak mají přístup ke kameře pouze 

přidané IP adresy. Pokud je možnost Filtering Mode nastavena na Deny Access, pak mají přístup ke 
kameře pouze přidané IP adresy. 

 Je povoleno až 32 IP adres. Každá IP adresa může být přidána pouze jednou. 
 První bajt každé IP adresy musí být 1-223 a čtvrtý nemůže být 0. Například následující IP adresy 

jsou zakázané a nemohou být přidány: 0.0.0.0, 127.0.0.1, 255.255.255.255, 224.0.0.1. 

 

Přístupová politika 

 ZAPAMATUJTE SI! 
Povolení přátelského hesla nemá vliv na používání. Pokud toto vypnete a přihlásíte se pod slabým heslem, 
zobrazí se stránka s výzvou ke změně hesla. Na této stránce není tlačítko Zrušit nebo Zavřít. Výchozí heslo 
je považováno za slabé. 

 

1. Klikněte na možnost Setup > Security > Network Security > Access Policy. 

 
2. Vyberte možnost On a povolit telnet, přátelské heslo a ověřování MAC. 

3. Klikněte na možnost Save. 

Vodoznak 

Použijte vodoznak k šifrování vlastních informací pomocí videa, abyste zabránili neoprávněnému vymazání 
nebo změně. 

 ZAPAMATUJTE SI! 
Tuto funkci podporují pouze některé modely kamery. 

 

1. Klikněte na možnost Setup > Security > Watermark. 

 

2. Výběr možnosti On aktivujte vodoznak a poté zadejte obsah vodoznaku. 

3. Klikněte na možnost Save. 

Nastavení systémového času 

Pro úpravu systémového času vašeho zařízení můžete použít následující metody. 
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Manuální nastavení nebo synchronizace systémového času 

1. Klikněte na možnost Setup > Common > Time a potom klepněte na kartu Time. 

  

2. Vyberte režim synchronizace. 

3. Nastavte správné časové pásmo a systémový čas. Také můžete kliknout na možnost Sync with 
Computer Time a synchronizovat nastavení času vaší kamery s časem vašeho počítače. 

4. Klikněte na možnost Save. 

Synchronizace se serverem NTP 

1. Klikněte na možnost Setup > Common > Time a potom klepněte na kartu Time. 

 
2. Nastavte možnost Sync Mode na Sync with NTP Server a poté nastavte adresu IP serveru NTP a 

interval aktualizace. 

3. Klikněte na možnost Save. Kamera bude periodicky synchronizovat čas se serverem NTP. 

Nastavení DST 

1. Klikněte na možnost Setup > Common > Time a potom klepněte na kartu DST. 

 

2. Nastavte možnost On pro DST, nastavte čas začátku, čas ukončení a zkreslení DST. 

3. Klikněte na možnost Save. 

Nastavení serverů 

Inteligentní server 

Pokud je ultra-citlivá kamera spravována centrálním serverem, je nutné nakonfigurovat inteligentní server. 

 ZAPAMATUJTE SI! 
 Pouze některé modely kamer podporují inteligentní server. 
 Chcete-li použít snímek tváře, je nutné nakonfigurovat server TMS, do kterého jsou snímky 

nahrávány. 
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1. Klikněte na možnost Setup > Common > Server a poté klikněte na kartu Intelligent Server. 

 
2. Nastavte adresu IP serveru TMS a proveďte další nastavení. 

3. Klikněte na možnost Save. 

Konfigurace režimu sériového portu 

Sériový port RS485 se používá pro výměnu dat se zařízením třetí strany. Nastavení sériového portu v 
kameře by mělo odpovídat nastavení připojeného zařízení třetí strany. 

 ZAPAMATUJTE SI! 
Tato funkce není u některých modelů podporována. Podrobnosti naleznete u aktuálního modelu. 

 

Ovládání PTZ 

Chcete-li ovládat kameru PTZ prostřednictvím zařízení třetí strany, je nutné nastavit možnost Port Mode na 
PTZ Control.  

Odesláním příkazů PTZ kompatibilních s PELCO-D přes port RS485 můžete ovládat kameru PTZ bez použití 
ovládacího panelu PTZ. 

1. Klikněte na možnost Setup > System > Ports & Devices a poté klikněte na kartu Serial Port. 
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2. Vyberte možnost PTZ Control z rozevírací nabídky Port Mode. V následující tabulce jsou popsány 
některé hlavní parametry. 

Parametr Popis 

PTZ Protocol 

Nastavte protokol PTZ, který daný kanál podporuje. 

Poznámka: 
 Tento parametr lze nastavit pouze v případě, že možnost Port Mode je nastavena na PTZ 

Control.  
 Když je možnost PTZ Protocol nastavena na INTERNAL-PTZ, kamera se může připojit k 

externímu PTZ bez použití sériového portu (parametry sériového portu jsou zašedlé). V 
tomto případě stačí připojit rozhraní přiblížení a ostření kamery k objektivu a poté lze 
ovládat PTZ jako interní PTZ. 

PTZ Mode 

 Vestavěná priorita PTZ: Když je vybrána tato volba, kamera se nejprve pokusí ovládat 
PTZ (například přiblížit nebo zaostřit) sama o sobě namísto přes externí PTZ. Pro 
operace, které kamera nemůže sama provést, používá kamera externí PTZ. 

 Externí priorita PTZ: Kamera se nejprve pokusí ovládat PTZ prostřednictvím PTZ 
připojeného přes sériový port. 

Poznámka: 
 Tento parametr lze nastavit pouze v případě, že možnost Port Mode je nastavena na PTZ 

Control. 
 Když je vybraná možnost INTERNAL-PTZ, tento parametr je vždy nastaven na Built-in PTZ 

Priority a není nutné připojovat kameru k externímu PTZ přes sériový port. Ovládání 
prostřednictvím externího PTZ není účinné i při připojení fotoaparátu k externímu PTZ. 

 Nastavte tento parametr podle potřeby. Ujistěte se, že rozhraní pro ovládání PTZ jsou 
správně připojena. 

Address Code 

Nastavte kód adresy pro PTZ. 

Poznámka: 
Tento parametr můžete nastavit pouze tehdy, když je možnost Port Mode nastavena na PTZ 
Control a PTZ Protocol není nastaveno na INTERNAL-PTZ. 

 

3. Klikněte na možnost Save. 

Transparentní kanál 

Pomocí sériového portu RS485 dosáhnete transparentního přenosu dat pomocí zařízení třetí strany. 
Transparentní kanál se používá hlavně k dosažení transparentního přenosu dat mezi dvěma zařízeními. 

 ZAPAMATUJTE SI!  
 Tato funkce není u některých modelů podporována. Podrobnosti naleznete u aktuálního modelu. 
 Nezapomeňte nastavit možnost Port Mode na Trans-Channel pro vaši kameru. 
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1. Klikněte na možnost Setup > System > Ports & Devices a poté klikněte na kartu Serial Port. 

 
2. Vyberte možnost Trans-Channel z rozevírací nabídky Port Mode. 

3. Vyberte možnost Enable pro Trans-Channel. 

4. Zadejte cílovou adresu IP a číslo portu (adresa IP a číslo portu, k němuž se transparentní kanál 
připojuje). 

5. Klikněte na možnost Save. 

OSD 

Chcete-li zobrazit informace ze zařízení třetí strany na obrazovce OSD, je nutné zvolit OSD jako režim portu. 

Kamera přijímá informace ze zařízení třetí strany prostřednictvím sériového portu RS485, přenáší přijaté 
informace a poté je zobrazuje na obrazovce OSD. 

 ZAPAMATUJTE SI! 
Chcete-li kameru aktivovat správně tak, aby přenášela informace přijaté od zařízení třetí strany, ujistěte 
se, že informace odeslané zařízením třetí strany prostřednictvím sériového portu odpovídají datovému 
formátu specifikovanému naší společností. Další informace získáte u prodejce. 

1. Klikněte na možnost Setup > System > Ports & Devices a poté klikněte na kartu Serial Port. 

 

2. Vyberte možnost OSD z rozevírací nabídky Port Mode. Vyberte možnost Enable OSD Report (takže 
data OSD budou nahrána na platformu). 

3. Klikněte na možnost Save. 
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Transparentní kanál ONVIF 

Přenášejte data přes transparentní kanál (ONVIF) mezi porty RS485 kamery a zařízeními třetí strany. 

1. Klikněte na možnost Setup > System > Ports & Devices a poté klikněte na kartu Serial Port. 

 

2. Nastavte možnost Port Mode na Select Trans-Channel via ONVIF. 

3. Klikněte na možnost Save. 

Řízení stěrače 

Nastavte parametry stěrače, abyste mohli ovládat stěrač. 

 ZAPAMATUJTE SI!  
Tato funkce není u některých modelů podporována. Podrobnosti naleznete u aktuálního modelu. 

 

1. Klikněte na možnost Setup > System > Ports & Devices a poté klikněte na kartu External Device. 

 

2. Nastavte řídicí režim stěrače. V následující tabulce jsou popsány některé hlavní parametry. 

Parametr Popis 

Serial Port Stěrač je řízen instrukcemi PELCO-D; proto by měl být protokol PTZ nastaven na PELCO-D. 
Viz Ovládání PTZ pro podrobnosti. 

Alarm Input/ 
Output Použijte alarmový vstup a výstup pro otevření nebo zavření obvodu a ovládání stěrače. 

 

Zobrazení stavu zařízení 

Můžete zobrazit aktuální stav kamery. 

1. Klikněte na možnost Setup > Common > Basic Info. 

2. Klikněte na možnost  Refresh pro nejnovější informace o stavu. 

3. Zobrazení informací o zařízení. 
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Stav úložiště snímků 

Zobrazení aktuálního stavu úložiště snímků. Úplné zásady úložiště viz Úložiště – paměťová karty. 

 ZAPAMATUJTE SI!  
Pouze modely s funkcí úložiště podporují tuto funkci. Podrobnosti naleznete u aktuálního modelu. 

 

1. Klikněte na možnost Photo. 

 

2. Klikněte na možnost Refresh pro aktualizaci stavu úložiště. 

3. Snímky můžete exportovat nebo odstranit v oblasti Image List. 

Upgrade zařízení 

Pokud je zařízení spravováno centrálním serverem pro správu a chcete aktualizovat zařízení v dávkovém 
režimu, doporučuje se provést upgrade na centrálním serveru. Podrobné kroky naleznete v uživatelské 
příručce centrálního serveru pro správu. 

1. Klikněte na možnost Setup > System > Maintenance. 

 
2. V části Software Upgrade klikněte na možnost Browse a vyberte správný soubor upgradu. 

3. Klikněte na možnost Upgrade a pak potvrďte spuštění. Kamera se po dokončení upgradu automaticky 
restartuje. Některá zařízení podporují aktualizaci zaváděcího programu. Chcete-li provést upgrade, 
vyberte možnost Upgrade Boot Program. 

4. Můžete kliknout na možnost Detect a zkontrolovat nové verze dostupné pro upgrade pomocí cloudu. 
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 ZAPAMATUJTE SI! 
 Pro kameru je nutné použít správný soubor upgradu. V opačném případě může dojít k 

neočekávaným výsledkům. 
 Soubor upgradu je soubor ZIP a musí obsahovat všechny potřebné soubory. 
 Zaváděcí program načte operační systém a systém se spustí. Funkce spouštěcího programu pro 

upgrade je ve výchozím nastavení zakázána a pouze kamera bude aktualizována na nejnovější 
verzi. Pokud je možnost povolena, budou aktualizovány program kamery i zaváděcí program. 
Operační systém následujících verzí bude možné řádně zavést a kameru pohodlně upgradovat. 

 Během upgradu se ujistěte, že je napájení normální. Zařízení se po dokončení upgradu automaticky 
restartuje. 

 

Restart systému 

1. Klikněte na možnost Setup > System > Maintenance. 

 
2. V části Device Restart klikněte na možnost Restart. Po potvrzení operace se zařízení restartuje.  

 
UPOZORNĚNÍ! 
Tuto operaci provádějte opatrně, protože při restartování systému se přeruší probíhající služba. 

 

Import a export souboru konfigurace systému 

Exportujte aktuální konfiguraci kamery a uložte je do počítače nebo na externí paměťové médium. Můžete 
také rychle obnovit konfigurace importováním konfigurací záloh uložených v počítači nebo z externího 
paměťového média zpět do kamery. 

 
UPOZORNĚNÍ!  

 Po provedení operace uvedení do výchozího stavu se všechna nastavení obnoví na výchozí tovární 
hodnoty s výjimkou následujícího: přihlašovací heslo správce systému, nastavení sítě a systémový 
čas. 

 Ujistěte se, že jste importovali správný konfigurační soubor kamery. V opačném případě může dojít 
k neočekávaným výsledkům. 

 Po úspěšném importu konfiguračního souboru se kamera restartuje. 

 

1. Klikněte na možnost Setup > System > Maintenance. 

 

2. Chcete-li importovat konfigurace, které jste zálohovali, klepněte na tlačítko Browse vedle tlačítka 
Import a vyberte konfigurace, které chcete importovat. Poté klepněte na tlačítko Import. Zobrazí se 
výsledek. 

3. Chcete-li exportovat konfigurace, klepněte na tlačítko Export a vyberte cílovou složku. 
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4. Chcete-li obnovit výchozí konfigurace, klepněte na tlačítko Default a pak potvrďte operaci. Zařízení se 
restartuje a obnoví výchozí konfigurace. 

Shromažďování diagnostických informací 

Diagnostické informace zahrnují protokoly a konfigurace systému. Diagnostické informace můžete 
exportovat do počítače. 

1. Klikněte na možnost Setup > System > Maintenance. 

 

2. V části Diagnosis Info klikněte na možnost Export a vyberte cílovou složku. 

 ZAPAMATUJTE SI! 
 Diagnostické informace jsou exportovány do místní složky ve formě komprimovaného souboru. 

Soubor je nutné dekomprimovat pomocí určitého nástroje, např. WinRAR, a poté jej otevřít v 
textovém editoru. 

 Vyberete-li možnost Collect Image Debugging Info můžete současně zobrazit video a informace o 
ladění, což usnadňuje odstraňování problémů. 

Konfigurace zaostření 

Zařízení může nastavit rychlost automatického zaostření podle minimální vzdálenosti zaostření. Chcete-li 
snímat zaostřené objekty, doporučujeme, aby vzdálenost minimálního zaostření byla nastavena kratší než 
vzdálenost mezi objekty a objektivem, například pokud je minimální zaostřovací vzdálenost 3 m, pak 
objekty ve vzdálenosti do 3 m od objektivu nebudou zaostřeny . 

 ZAPAMATUJTE SI! 
Tuto funkci podporují pouze přístroje s automatickým ostřením. Podrobnosti naleznete u aktuálního 
modelu. 

1. Klikněte na možnost Setup > System > Maintenance. 

 

2. V části Focus konfigurujte možnost Min. Focus Distance (jednotka: cm) a Max. Zoom Ratio. 

3. Klikněte na tlačítko OK. 
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Montážní výška zařízení 

Zadejte skutečnou výšku z nainstalované infračervené kopule od země tak, aby kopule dokázala 
automaticky nastavit svou infračervenou lampu. 

 ZAPAMATUJTE SI! 
Tuto funkci podporují pouze některé infračervené kamery. Podrobnosti naleznete u aktuálního modelu. 

1. Klikněte na možnost Setup > System > Maintenance. 

 

2. Zadejte skutečnou výšku namontované infračervené kopule od země. 

3. Klikněte na tlačítko OK. 

Parametr kamer rybí oko 

Pro správné zobrazení videa je nutné správně nastavit parametry rybího oka podle aktuálního režimu 
montáže. 

 ZAPAMATUJTE SI! 
Tuto funkci podporují pouze některé kamery – rybí oko. Podrobnosti naleznete u aktuálního modelu. 

 

1. Klikněte na možnost Live View > Mount. Vyberte režim montáže. Zvolený režim montáže musí 
odpovídat aktuálnímu režimu montáže. 
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U některých modelů kamer se stránka zobrazí následujícím způsobem. 

 
2. Nastavte parametry. V následující tabulce jsou popsány některé hlavní parametry. 

Parametr Popis 

 

 

 

 

 

 

 

 

 

 

 

Jedenáct režimů zobrazení: 

 Původní obraz 
 Panoramatický 
 Panoramatický + 3PTZ 
 Panoramatický + 4PTZ 
 Panoramatický + 8PTZ 
 360° panoramatický + 1PTZ 
 180° panoramatický 
 Rybí oko + 3PTZ 
 Rybí oko + 4PTZ 
 360° panoramatický + 6PTZ 
 Rybí oko + 8PTZ 

 

 

 

Tři způsoby montáže: 

• Strop 

• Stěna 

• Stůl 

Poznámka: 
Zvolený režim montáže musí odpovídat aktuálnímu režimu montáže. 
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4  Živé zobrazení 

Živé zobrazení znamená přehrávání živého videa (zvuk a video v reálném čase), které bylo přijato z kamery v 
okně prostřednictvím webového rozhraní. 

Pokud se přihlásíte při zaškrtnutém políčku Live View, zobrazí se ve výchozím nastavení při přihlášení živé 
video. Na toto okno můžete dvakrát kliknout a otevřít nebo ukončit režim celé obrazovky. 

 

Panel nástrojů živého zobrazení 

 ZAPAMATUJTE SI! 
Podporované operace živého pohledu se mohou lišit podle modelu kamery. Operace, které vaše kamera 
podporuje, naleznete na webovém rozhraní. 

 

Tlačítko Popis 

/  Přehrávání/zastavení živého videa. 

 

Upravte výstupní hlasitost přehrávače médií v počítači. 

 

Upravte hlasitost mikrofonu v počítači během audio komunikace mezi počítačem a 
kamerou. 

 

Zachyťte snímek aktuálního obrazu zobrazeného v počítači. 

Poznámka:  
Cesta k ukládání snímků je nastavena v položce System Configuration. 

/  

Spustit/zastavit místní nahrávání. 

Poznámka:  
Cesta pro ukládání místních záznamů je nastavena v položce System Configuration. 

/  Spustit/zastavit komunikaci mezi počítačem a kamerou. 

/  
Spuštění/zastavení digitálního zoomu. Více podrobností viz Použití digitálního 
přiblížení. 
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Tlačítko Popis 

/  Spuštění/zastavení zaostření oblasti. Více podrobností viz Použití oblast ostření. 

/  Spuštění/zastavení 3D polohování Více podrobností viz Použití 3D polohování. 

 Zobrazit/skrýt ovládací panel PTZ. 

 

Nastavte poměr zobrazení obrazu v okně. Chcete-li například zobrazit obraz s 
vysokým rozlišením v původním formátu 16: 9, vyberte možnost Scale, pro 
zobrazení podle velikosti okna vyberte Stretch a pro zobrazení s původní velikostí 
obrázku zvolte možnost Original. 

 

Resetujte míru ztráty paketů na nulu. 

Poznámka:  
Po přesunutí kurzoru myši do okna živého zobrazení se toto tlačítko zobrazí na 
plovoucím panelu nástrojů. 

 

Zobrazit rychlost ztráty paketů a informace o přenosové rychlosti ve spodní části 
okna. 

Poznámka: 

Po přesunutí kurzoru myši do okna živého zobrazení se toto tlačítko zobrazí na 
plovoucím panelu nástrojů. 

Po kliknutí na toto tlačítko se vždy zobrazí informace. Po dalším kliknutí se 
informace zobrazí pouze tehdy, když přesunete ukazatel myši nad okno nebo jej 
umístíte dolů. Pokud ukazatel myši spočívá nad okně po dobu přibližně 3 sekund 
nebo opustí okno, informace zmizí. 

 Klepnutím na toto tlačítko otevřete stránku nastavení obrazu.  

 Zobrazit v režimu celé obrazovky. 

 

 

 

Vyberte živý video stream, který kamera podporuje: hlavní stream, sub stream 
nebo třetí stream. 

 

Zobrazení určité oblasti obrazu 

Digitální přiblížení, zaostření oblasti a 3D polohování umožňují získat více detailů o určité části obrazů. 
Digitální zoom zvětšuje obraz se ztrátou kvality obrazu, zatímco 3D polohování zvětšuje obraz beze ztráty. 

Použití digitálního přiblížení 

 ZAPAMATUJTE SI! 
Podporované operace živého pohledu se mohou lišit podle modelu kamery. Operace, které vaše kamera 
podporuje, naleznete na webovém rozhraní. 
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1. Na stránce Live View klikněte na možnost  na panelu nástrojů. 

 
2. Klepnutím a podržením tlačítka myši a přetažením shora dolů (nakreslete obdélník) určete příslušnou 

oblast. Chcete-li obnovit původní velikost obrazu a přiblížit jiné oblasti obrazu, klepněte pravým 
tlačítkem myši. 

3. Pro ukončení klepněte na tlačítko . 

Použití oblast ostření 

 ZAPAMATUJTE SI! 
Podporované operace živého pohledu se mohou lišit podle modelu kamery. Operace, které vaše kamera 
podporuje, naleznete na webovém rozhraní. 

1. Na stránce Live View klikněte na možnost  na panelu nástrojů. 
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2. Klepnutím a podržením tlačítka myši a přetažením shora dolů (nakreslete obdélník) určete příslušnou 
oblast. 

3. Pro ukončení klepněte na tlačítko . 

Použití 3D polohování 

 ZAPAMATUJTE SI! 
Tato funkce je k dispozici pouze pro síťové kamery PTZ a síťové kamery vybavené motoricky ovládaným 
objektivem a PTZ. Podrobnosti naleznete u skutečných modelů. 

 

1. Na stránce Live View klikněte na možnost  na panelu nástrojů. 

 
2. Klepnutím a podržením tlačítka myši a přetažením shora dolů (nakreslete obdélník) určete příslušnou 

oblast. Při obráceném přetažení (od horní části) dojde ke zmenšení. 

3. Pro ukončení klepněte na tlačítko . 

Živé zobrazení kamery – rybí oko 

 

ZAPAMATUJTE SI! 
 Tuto funkci podporují pouze některé síťové kamery – rybí oko. Podrobnosti naleznete u skutečných 

modelů. 
 Náhled obrazu na webu se může lišit podle nastavení rybího oka kamery. Nastavte parametry 

rybího oka (viz část Parametr kamer rybí oko) a režim rybího oka (viz část Konfigurace videa) 
kamery před spuštěním živého zobrazení.  
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Režimy zobrazení obsahují tři hlavní typy: Původní obraz, rybí oko a PTZ, panoramatické a PTZ V různých 
režimech montáže se obrazy zobrazují jinak. V následující části je jako příklad uveden držák na stěnu. 

Je-li vybrána možnost Original Image, obrazy rybího oka se zobrazují následovně. 

 
Pokud je vybrána možnost Panoramatický, narovnané panoramatické snímky se zobrazí následovně. 
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ZAPAMATUJTE SI! 
Pokud je použita montáž na strop nebo montáž na stůl, panoramatický snímek (dva obrázky 180°) je 
narovnaný obraz náhledu rybího oka (obraz 360°). Připevněte kameru pod vhodným úhlem záběru podle 
skutečných požadavků na sledování. 
Pokud je například kamera instalována na strop, je cíl sledování zobrazen v horní části panoramatického 
obrazu, když je úhel průniku mezi vývodem kabelu zařízení (logo) a cílem sledování 135° ve směru 
hodinových ručiček. 
 

 
 

Když je v seznamu vpravo vybrán režim náhledu Panoramatický + 4PTZ, zobrazují se ve výchozím nastavení 
4 místní obrazy, zleva doprava, shora dolů. Ovládání PTZ a operace přiblížení můžete provést na každém 
místním obrazu, jak je znázorněno na obrázku níže. 

 

LOGO

Cable 
outlet

45°

Position of surveillance target
(e.g. access control)

Target

Target

Device 
bottom

360° Fisheye image in 
fisheye preview mode

Panorama image in 
panorama preview mode

 
Obraz – rybí oko 360° v 

režimu náhledu rybího oka 
Panoramatický obraz v 

panoramatickém režimu náhledu 

Poloha cíle sledování  
(např. řízení přístupu) 

Cíl 

Vývod 
kabelu 

Spodní část 
zařízení 
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5  Přehrávání videa a stahování pomocí úložiště v 
zařízení 

 ZAPAMATUJTE SI! 
 Úložiště v zařízení se týká záznamu videa na paměťovou kartu frontendového zařízení (většinou 

kamery). Místní nahrávání znamená nahrávání videa do místního klienta v přenosném počítači. 
 Než přehrajete video s úložištěm v zařízení, zkontrolujte, zda byla do kamery vložena paměťová 

karta a zda byl nakonfigurován úložný prostor. 
 Tato funkce není u některých modelů podporována. Podrobnosti naleznete u skutečných modelů. 

Přehrávání videa 

1. Klikněte na možnost Playback na domovské stránce. 

 
2. Vyberte datum z kalendáře. 

3. Klikněte na možnost Query. 

4. V části Results klidně za dvakrát na časové období a začněte přehrávat záznam. 

Stažení 

1. Klikněte na možnost Playback na domovské stránce. 
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2. Vyhledávání videa v určeném období. Výsledky se zobrazí v seznamu. 

3. Vyberte video a klikněte na možnost Download. Video se stáhne z místní cesty z paměťové karty 
(místní cesta může být změněna v části Local Settings). 

4. Kliknutím na možnost Open zobrazíte složku, v níž je stažené video uloženo. 

6  Ovládání PTZ 
Tato funkce je k dispozici pouze pro kupolovité kamery PTZ nebo pro box kamery nainstalované na motoru 
pro otáčení/náklon.  

 ZAPAMATUJTE SI! 
 Některé funkce ovládání objektivu platí pro kamery vybavené motorizovanými objektivy. 
 Tlačítka ovládání PTZ se mohou lišit podle modelu kamery. Tlačítka ovládání PTZ, které vaše 

kamera podporuje, naleznete na webovém rozhraní. 

Panel nástrojů ovládání PTZ 
Položka Popis 

Preset 

Vyberte přednastavenou pozici a klikněte na . Kamera PTZ přejde na 
přednastavenou pozici. 

Chcete-li přidat přednastavenou pozici, klikněte na možnost . Chcete-li 
přednastavenou pozici odstranit, klikněte na možnost . 

Patrol 

Vyberte trasu hlídky a potom klepněte na tlačítko  pro spuštění hlídky.  

 Chcete-li upravit trasu hlídky, klepněte na . 

 Chcete-li přidat trasu hlídky, klepněte na . 

 Chcete-li odstranit trasu hlídky, klepněte na . 

 

Nastavte rychlost pohybu kamery PTZ. 

 

Ovládejte směr kamery PTZ a uvolněte ovládání. 

/  

/  

/  

/  

/  

Zapněte nebo vypněte IR. 

Zapněte nebo vypněte stěrač. 

Zapněte nebo vypněte ohřev. 

Zapněte nebo vypněte osvětlení. 

Zapněte nebo vypněte ovládání sněhu. 
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Položka Popis 

 

Upravte zaostření kamery. 

 

Upravte přiblížení kamery. 

 

Zvyšte nebo snižte průměr clony. 

 

Klávesové zkratky pro ovládání PTZ. Jakmile se ukazatel myši změní na některý z 
těchto tvarů v živém zobrazení, klikněte a podržte levé tlačítko myši pro ovládání 
kamery PTZ. 

Poznámka: 
 Tuto funkci podporují pouze kopulovité kamery PTZ a kamery PTZ. 
 Tato tlačítka jsou nepoužitelná, pokud používáte 3D polohování nebo digitální 

přiblížení. 

 

Klávesové zkratky pro přiblížení nebo oddálení v živém zobrazení. Otočte kolečkem 
dopředu, chcete-li provést přiblížení, nebo otočte vzat pro oddálení. 

Poznámka: 
Pouze kamery s motoricky ovládaným objektivem podporují tuto funkci. 

 

Nastavení hlídky podle přednastavených pozic 

Nastavení přednastavených pozic 

Na kartě Preset můžete spravovat přednastavené pozice nebo provádět určité operace s kamerou PTZ. Více 
podrobností viz Panel nástrojů ovládání PTZ. 

Přidat přednastavenou pozici 

1. Na stránce Live View klikněte na možnost Preset na panelu nástrojů. 

 
2. Kameru nastavte tak, aby ukazovala požadovaným směrem. 

3. Přizpůsobte přiblížení a zaostření podle potřeby, abyste získali optimální obraz. 

1

2

3

4
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4. Kliknutím na možnost  ji přidáte jako přednastavenou pozici. Zadejte číslo a název přednastavené 
pozice a klepněte na tlačítko OK. 

Přechod na přednastavenou pozici 

1. Na stránce Live View klikněte na možnost Preset na panelu nástrojů. 

 

2. Klikněte na  pro přednastavenou pozici. Kamera PTZ přejde na přednastavenou pozici. 

Odstranění přednastavené pozice. 

1. Na stránce Live View klikněte na možnost Preset na panelu nástrojů. 

 

2. Klikněte na možnost  pro výběr určité přednastavené pozice a poté potvrďte odstranění. 

  

1 2

1 2
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Nastavení hlídky 

Trasa hlídky je stopa, kterou kamera PTZ sleduje při přesunu z jedné přednastavené pozice na další. Dobu, 
po kterou kamera PTZ zůstane u každé přednastavené pozice, lze konfigurovat. Pro kameru PTZ je povoleno 
několik tras hlídky. 

Akce hlídky zahrnují přechod naučit o přednastavenou pozici a prodlevu na určité nastavené pozici po 
určitou dobu předtím, než kamera přejde na další. Můžete nastavit směr otáčení, přiblížení, rychlost 
otáčení, dobu hlídky a dobu prodlevy. Systém zaznamená trasu a přidá ji do seznamu akcí. Můžete vybrat 
možnost Keep Rotating takže kamera PTZ bude sledovat stejnou trasu a hlídky opakovaně. 

Přidání trasy hlídky 

1. Na stránce Live View klikněte na možnost Patrol na panelu nástrojů. 

 

2. Klikněte na . 
3. Na stránce Add Patrol zadejte ID a název trasy a klepnutím na tlačítko Add přidejte určitou akci hlídky. 

Je povoleno až 64 akcí. Každý řádek obsahuje dvě akce, při kterých je nastaven typ akce na Move 
Direction a Zoom, takže je povoleno 32 akcí. Pomocí tlačítek upravte posloupnost akcí. 

Akce hlídky zahrnují: 

 Přechod na hlídku a prodlévání po určitou dobu, než se přejde na další přednastavenou pozici. 

 Je-li vybrána položka Keep Rotating – otáčení nastavenou rychlostí ve stanoveném směru po určitou 
dobu, přiblížení, prodlévání na určité pozici po určitou dobu, nebo opakované hlídání. 

Doporučuje se, aby byl první typ akce Go to Preset. 

4. Klikněte na tlačítko OK. 
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Záznam trasy hlídky 

1. Na stránce Live View klikněte na možnost Patrol na panelu nástrojů. 

 

2. Kliknutím na možnost  spustíte záznam trasy hlídky. Během záznamu můžete nastavit směr a 

přiblížení kamery. Systém zaznamená pohyb a stopu kamery a přidá je do seznamu akcí. 

3. Klepnutím na  dokončíte nahrávání. Poté se trasa hlídky automaticky uloží jako trasa režimu. 
Kliknutím na možnost  spustíte vyhlídku nebo kliknutím na  odstraníte trasu režimu. 

 

  

1

2
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Vytvoření plánu hlídky 

1. Na stránce Live View klikněte na možnost Patrol na panelu nástrojů. 

 

2. Klikněte na . Zobrazí se stránka pro nastavení plánů hlídky. 

3. Nastavte správný čas a trasu hlídky. 

4. Vyberte možnost Enable Patrol Plan. 

5. Klikněte na tlačítko OK. 

Spuštění trasy hlídky 

Po přidání trasy hlídky vyberte trasu hlídky a spusťte hlídku. 

1. Na stránce Live View klikněte na možnost Patrol na panelu nástrojů. 

 
2. Klikněte na  pro trasu hlídky, kterou chcete spustit. 

  

1

2

1
2



80 

Úprava trasy hlídky 

1. Na stránce Live View klikněte na možnost Patrol na panelu nástrojů. 

 

2. Klikněte na  pro trasu hlídky, kterou chcete upravit, a upravte požadovaná nastavení. 
Odstranění trasy hlídky 

1. Na stránce Live View klikněte na možnost Patrol na panelu nástrojů. 

 

2. Klikněte na  pro trasu hlídky, kterou chcete odstranit a poté potvrďte odstranění. 

Nastavení výchozí polohy 

Kamera PTZ se vrátí do výchozí polohy, pokud během určité doby nedojde k žádné akci. 

 ZAPAMATUJTE SI! 
 Tato funkce je k dispozici pouze pro síťové kamery PTZ. 
 Nejprve je nutné přidat přednastavené pozice nebo trasu hlídky. Podrobnosti viz Přidat přednastavenou 

pozici a Přidání trasy hlídky. 

1
2

1
2
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1. Klikněte na možnost Setup > PTZ > Home Position. 

 
2. Vyberte režim a ID. 

3. Klikněte na možnost Save. 

Vzdálené ovládání PTZ 

Pokud je použita platforma třetí strany a protokol PTZ tomu neodpovídá, můžete nastavit funkci vzdáleného 
ovládání pro ovládání PTZ. 

 ZAPAMATUJTE SI! 
Tuto funkci podporují pouze některé kamery PTZ. 

 

1. Klikněte na možnost Setup > PTZ > Remote Control. 

 
2. Vyberte možnost On pro povolení Remote Control. Nastavte port pro naslouchání a kód adresy. 

V následující tabulce jsou popsány některé hlavní parametry. 

Zkratka Popis  

Listener Port Místní port kamery, což nemůže být port, který se již používá. Změňte 
výchozí nastavení pouze v případě potřeby. 

Address Code 
Kamera může přečíst kód adresy uvedený v instrukcích. Kamera interpretuje 
instrukce pouze tehdy, když kód adresy v instrukci odpovídá zde 
konfigurovanému kódu adresy. 

 

3. Klikněte na možnost Save. 

Limit PTZ 

Nastavte limity rotace, aby se zabránilo tomu, že kamera PTZ narazí do překážky, například do stěny. 

 ZAPAMATUJTE SI! 
Tuto funkci podporují pouze některé kamery PTZ. 
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1. Klikněte na možnost Setup > PTZ > PTZ Limit.  

 
2. Pomocí směrových tlačítek otočte kameru do určené polohy. 

3. Kliknutím na možnost  nastavíte aktuální polohu jako limit. Například klikněte na  v horní části 

pro nastavení horního limitu. Kliknutím na  otočíte kameru do aktuální polohy, pokud byl změněn 

směr. 

4. Opakujte výše uvedené kroky, chcete-li nastavit všechny limity podle potřeby (nahoru, dolů, doleva, 
doprava). 

5. Klikněte na možnost Save. 

6. Kliknutím na možnost Start PTZ Limit nastavení použijete. 

7. Kliknutím na možnost  odstraníte nastavení a resetuje limit. 

Obnovení hlídky 

1. Klikněte na možnost Setup > PTZ > Patrol. 

 

2. Nastavte čas, kdy se hlídka obnoví. 

3. Klikněte na možnost Save. 

 

 

1

2

3

4
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Dodatek A – glosář 

Zkratka Popis  

ARP Protokol pro překlad adres 

CBR Konstantní přenosová rychlost 

DNS služba DNS 

DDNS Dynamická služba DNS 

DHCP Konfigurační protokol dynamického hosta 

DST Letní čas 

FTP Protokol FTP 

GOP skupina obrázků 

GUI Grafické uživatelské rozhraní 

HTTPS protokol HTTP přes SSL 

IE Internet Explorer 

IMOS IP adresa multimediálního operačního systému 

IP internetový protokol 

IPC IP kamera 

MTU maximální přenosová jednotka 

NTP Protokol NTP  

OSD zobrazení na obrazovce 

PoE Napájení přes Ethernet 

PPPoE Protokol Point-to-Point přes Ethernet 

PTZ Otáčení, náklon, přiblížení 

ROI oblast zájmu 

SMTP protokol SMTP 

SSL Vrstva bezpečných socketů 

UNP univerzální síťový pas 

USB Univerzální sériová sběrnice 

VBR Proměnlivá přenosová rychlost 

WDR široký dynamický rozsah 
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Příloha B – často pokládané dotazy 

Co dělat, když se po prvním přihlášení k počítači se systémem Windows 7 neobjeví výzva k instalaci 
technologie ActiveX 

Odpověď: Následujícím postupem vypněte UAC a znovu se přihlaste:  

1. Klikněte na nabídku Start a pak na možnost Control Panel. 

2. Do vyhledávacího pole zadejte příkaz uac a potom klepněte na tlačítko Change User Account Control 
Settings.  

3. Přesuňte posuvník do polohy Never Notify a klepněte na tlačítko OK.  

4. Po vypnutí UAC se znovu přihlaste. 

 

Co dělat, pokud selže instalace technologie ActiveX 

Odpověď: Pokud instalace selhala, přidejte adresu IP fotoaparátu jako důvěryhodného místa: otevřete 
Internet Option v aplikaci IE, klikněte na kartu Security, klikněte na možnost Trusted sites a poté klikněte 
na Sites a přidejte webovou stránku.  

Používáte-li systém Windows 7, je nutné nejdříve uložit do počítače soubor setup.exe a potom na tento 
soubor klepnout pravým tlačítkem myši, zvolit Run as administrator a poté jej nainstalovat podle pokynů. 

 

Co dělat, když živé video selže po prvním přihlášení 

Odpověď: Zavřete bránu Firewall v počítači a znovu se přihlaste k webovému rozhraní. 


	1   Sítové připojení
	2   Přihlášení
	Příprava
	Kontrola před přihlášením
	Přidání adresy IP jako důvěryhodné webové stránky
	Úprava nastavení kontroly přístupu uživatele (volitelně)

	Přihlášení k webovému rozhraní
	1. Přejděte na přihlašovací stránku zadáním správné adresy IP kamery do adresního řádku.
	2. Pokud se přihlašujete poprvé, postupujte podle pokynů systému a nainstalujte ovládací prvek ActiveX. Chcete-li dokončit instalaci, je nutné zavřít prohlížeč.
	3. Zadejte uživatelské jméno a heslo a poté klikněte na tlačítko Login. Pro první přihlášení použijte výchozí uživatelské jméno „admin“ a heslo „123456“.

	Úvod k webovému rozhraní
	Počáteční konfigurace

	3   Konfigurace parametrů
	Místní parametry
	1. Vyberte možnost Setup > Common > Local Settings.
	2. Upravte nastavení podle potřeby. V následující tabulce jsou popsány některé hlavní parametry.
	3. Klikněte na možnost Save.

	Konfigurace sítě
	Ethernet
	Statická adresa
	1. Klikněte na možnost Setup > Network > Network.
	2. Vyberte možnost Static z rozevírací nabídky Obtain IP Address.
	3. Zadejte adresu IP, masku podsítě a výchozí adresu brány. Ujistěte se, že IP adresa kamery je v síti jedinečná.
	4. Klikněte na možnost Save.

	PPPoE
	1. Klikněte na možnost Setup > Network > Network.
	2. Vyberte možnost PPPoE z rozevírací nabídky Obtain IP Address.
	3. Zadejte uživatelské jméno a heslo, které poskytl váš poskytovatel internetových služeb (ISP).
	4. Klikněte na možnost Save.

	DHCP
	1. Klikněte na možnost Setup > Network > Network.
	2. Vyberte možnost DHCP z rozevírací nabídky Obtain IP Address.
	3. Klikněte na možnost Save.

	IPv6
	1. Klikněte na možnost Setup > Network > Network.
	2. Ve výchozím nastavení je režim IPv6 nastaven na možnost Manual.
	3. Zadejte adresu IPv6, nastavte délku předpony a výchozí bránu. Adresa IP musí být v síti jedinečná.
	4. Klikněte na možnost Save.

	Wi-Fi
	1. Klikněte na možnost Setup > Network > Network. Klikněte na kartu Wi-Fi.
	2. Vyberte možnost Sniffer.
	3. Klikněte na možnost Save.
	1. Vyberte možnost Setup > Network > Network. Vyberte možnost Wi-Fi v nabídce Wi-Fi Mode.
	2. Zobrazí se síla signálu. Zapněte možnost Adaptive Streams. Na stránce se zobrazí, že existují další sítě Wi-Fi. Chcete-li znovu vyhledat sítě Wi-Fi, klikněte na možnost Search.
	3. V seznamu sítí Wi-Fi klikněte na identifikátor SSID. Zobrazí se informace o příslušné síti.
	4. Klikněte na možnost Save.
	5. Pokud je možnost Wi-Fi Mode nastavena na položku Wi-Fi Hotspot, může kamera fungovat jako hotspot Wi-Fi pro ostatní zařízení.
	6. Klikněte na možnost Save.


	Port
	1. Klikněte na možnost Setup > Network > Port.
	2. Nakonfigurujte příslušná čísla portů.
	3. Klikněte na možnost Save.

	FTP
	Obecné
	1. Klikněte na možnost Setup > Storage > FTP. Přejděte na kartu General.
	2. Nastavte adresu IP a port pro server FTP, uživatelské jméno a heslo, které se používají k odesílání snímků na server FTP, vyberte možnosti Upload Images, Overwrite Storage a nastavte možnost Overwrite At (práh pro přepsání obrázků). Některé modely kamer�
	3. Nastavte cestu k ukládání snímků na server FTP a formát názvu souboru. Například nastavte cestu jako Č. předvolby\\Adresa IP\\Datum\\Hodina a nastavte název souborů jako Č. předvolby-Zoom PTZ-Zeměpisná šířka PTZ-Zeměpisná délka PTZ.jpg.
	4. Klikněte na možnost Save.

	Inteligentní
	1. Klikněte na možnost Setup > Storage > FTP. Přejděte na kartu Smart.
	2. Nastavte adresu IP a port serveru FTP, uživatelské jméno a heslo, které se používají k odesílání snímků na server FTP.
	3. Nastavte cestu k ukládání snímků na server FTP a formát názvu souboru. Například nastavte cestu jako Č. předvolby\\Adresa IP\\Datum a nastavte název souboru jako Č. předvolby-Zeměpisná šířka PTZ-Zeměpisná délka PTZ-Zoom PTZ.jpg.
	4. Klikněte na možnost Save.


	E-mail
	1. Klikněte na možnost Setup > Network > E-mail.
	2. Nakonfigurujte příslušné parametry odesílatele a příjemce. Některé modely kamer podporují test e-mailu. Po nastavení adresy příjemce můžete e-mail otestovat. V následující tabulce jsou popsány některé hlavní parametry.
	3. Klikněte na možnost Save.

	Mapování portů
	1. Klikněte na možnost Setup > Network > Port. Přejděte na kartu Port Mapping.
	2. Povolte možnost Port Mapping a vyberte typ mapování. Je-li vybrána možnost Manual, pak musí být nakonfigurovány externí porty (kamera získává automaticky externí adresu IP). Pokud je nakonfigurovaný port obsazen, pak bude možnost Status zobrazena jako n�
	3. Klikněte na možnost Save.

	DNS
	1. Klikněte na možnost Setup > Network > DNS.
	2. Nastavte adresy serverů DNS.
	3. Klikněte na možnost Save.

	DDNS
	1. Klikněte na možnost Setup > Network > DDNS.
	2. Povolte možnost DDNS Service.
	3. Vyberte typ DDNS: DynDNS, NO-IP nebo EZDDNS.
	4. Dokončete další nastavení včetně adresy serveru, názvu domény, uživatelského jména a hesla.
	5. Klikněte na možnost Save.

	EZCloud
	1. Klikněte na možnost Setup > Network > EZCloud.
	2. Vyberte možnost On a povolte cloudovou službu.
	3. Klikněte na možnost Save.

	802.1x
	1. Klikněte na možnost Setup > Network > 802.1x.
	2. Vyberte možnost On a poté dokončete další nastavení.
	3. Klikněte na možnost Save.


	Konfigurace obrazu
	Nastavení obrazu
	Nastavení scény
	1. Klikněte na možnost Scenes.
	2. Vyberte určitou scénu a poté nastavte parametry přepínání scén. V následující tabulce jsou popsány některé hlavní parametry.
	3. Vyberte scénu a poté ji kliknutím na možnost  nastavte jako výchozí scénu.
	4. Je-li povoleno automatické přepínání, kamera se automaticky přepne na scénu, pokud je splněna podmínka pro přepnutí na jinou než výchozí scénu. V opačném případě zůstává kamera na výchozí scéně. Pokud není zapnuto automatické přepínání, zůstane kamera n�

	Vylepšení obrazu
	1. Klikněte na možnost Setup > Image > Image a poté klikněte na položku Image Enhancement.
	2. Pomocí posuvníků změňte nastavení. Můžete také zadat hodnoty přímo. V následující tabulce jsou popsány některé hlavní parametry.
	3. Chcete-li obnovit výchozí nastavení v této oblasti, klikněte na položku Default.

	Expozice
	1. Klikněte na možnost Setup > Image > Image a poté klikněte na položku Exposure.
	2. Nastavte požadované parametry. V následující tabulce jsou popsány některé hlavní parametry.
	3. Chcete-li obnovit výchozí nastavení, klikněte na tlačítko Default.

	Inteligentní osvětlení
	1. Klikněte na možnost Setup > Image > Image a poté klikněte na položku Smart Illumination.
	2. Vyberte správný řídicí režim IR a nastavte parametry. V následující tabulce jsou popsány některé hlavní parametry.
	3. Chcete-li obnovit výchozí nastavení, klikněte na tlačítko Default.

	Ostření
	1. Klikněte na možnost Setup > Image > Image a poté klikněte na položku Focus.
	2. Zvolte režim ostření podle potřeby.
	3. Chcete-li obnovit výchozí nastavení, klikněte na tlačítko Default.

	Vyvážení bílé
	1. Klikněte na možnost Setup > Image > Image a poté klikněte na položku White Balance.
	2. Zvolte režim vyvážení bílé podle potřeby. V následující tabulce jsou popsány některé hlavní parametry.
	3. Chcete-li obnovit výchozí nastavení, klikněte na tlačítko Default.

	Rozšířené
	1. Klikněte na možnost Setup > Image > Image a poté klikněte na položku Advanced.
	2. Povolte funkci potlačení mlhy a poté vyberte úroveň scény. Úroveň 9 dosahuje maximálního účinku potlačení mlhy a úroveň 1 dosahuje minima.
	3. Chcete-li obnovit výchozí nastavení, klikněte na tlačítko Default.

	Typ osvětlení
	1. Klikněte na možnost Setup > Image > Image a poté klikněte na položku Smart Illumination
	2. V rozevírací nabídce zvolte možnost Lighting Type.
	3. Chcete-li obnovit výchozí nastavení, klikněte na tlačítko Default.

	Konfigurace režimu clony a objektivu
	1. Klikněte na možnost Setup > Image > Image a poté klikněte na položku Advanced.
	2. Upravte nastavení podle potřeby. V následující tabulce jsou popsány některé hlavní parametry.
	3. Chcete-li obnovit výchozí nastavení, klikněte na tlačítko Default.


	Nastavení OSD
	1. Klikněte na možnost Setup > Image > OSD.
	2. Zvolte pozici a obsah OSD.
	3. Po dokončení nastavení se zobrazí zpráva, která signalizuje úspěšné nastavení.

	Privátní maskování
	1. Klikněte na možnost Setup > Image > Privacy Mask.
	2. Kliknutím na možnost  přidejte privátní masku a kliknutím na tlačítko  masku odstraňte.


	Konfigurace zvuku a videa
	Konfigurace videa
	1. Klikněte na možnost Setup > Video & Audio > Video.
	2. Upravte nastavení podle potřeby. V následující tabulce jsou popsány některé hlavní parametry.
	3. Klikněte na možnost Save.

	Konfigurace zvuku
	1. Klikněte na možnost Setup > Video & Audio > Audio.
	2. Upravte nastavení podle potřeby. V následující tabulce jsou popsány některé hlavní parametry.
	3. Klikněte na možnost Save.

	Snímek
	1. Klikněte na možnost Setup > Video & Audio > Snapshot.
	2. Vyberte možnost On a poté podle potřeby nastavte rozlišení, kvalitu obrazu a harmonogram.
	3. Klikněte na možnost Save.

	ROI
	1. Klikněte na možnost Setup > Video & Audio > ROI.
	2. Klikněte na možnost  a poté přetáhněte myš k pokrytí zamýšlených částí obrazu. Chcete-li oblast odstranit, vyberte danou oblast a klepněte na tlačítko .

	Konfigurace datového proudu médií
	Stream médií
	1. Klikněte na možnost Setup > Video & Audio > Media Stream.
	2. Klikněte na možnost , vyberte typ streamu a poté nastavte adresu IP a číslo portu skupiny unicast nebo vícesměrového vysílání pro dekódovací zařízení, které přijímá z kamery audio a video streamy.
	3. Chcete-li stream odstranit, klikněte na .
	4. Dokončete operaci kliknutím na Submit.

	RTSP Multicast adresa
	1. Klikněte na možnost Setup > Video & Audio > Media Stream > RTSP Multicast Address.
	2. Nastavte adresu vícesměrového vysílání (224.0.0.0 na 239.255.255.255) a číslo portu (0 až 65535).
	3. Klikněte na možnost Save.



	Inteligentní konfigurace alarmu
	Inteligentní nastavení
	Detekce překročení linie
	1. Klikněte na možnost Setup > Intelligent > Smart Settings. Vyberte možnost  Cross Line a poté klikněte na .
	2. Vyberte možnost Cross Line Detection.
	3. V oblasti Detection Rule klikněte na možnost  a přidejte novou oblast detekce. Chcete-li odstranit oblast detekce, klepněte na tlačítko .
	4. V malém podokně náhledu přetáhněte linku do určené polohy a nastavte rozsah detekce.
	5. Nastavte směr a citlivost kamery – tím nastavíte, zda chcete hlásit alarm detekce překročení linie.
	6. Nastavte akce aktivace alarmu a plán aktivace podle potřeby. Podrobné kroky naleznete v popisu akcí vyvolaných alarmem v části Konfigurace alarmu detekce pohybu.
	7. Klikněte na možnost Save.

	Detekce vniknutí
	1. Klikněte na možnost Setup > Intelligent > Smart Settings. Vyberte možnost  Intrusion a poté klepněte na tlačítko .
	2. Vyberte možnost Intrusion Detection.
	3. V oblasti Detection Rule klikněte na možnost  a přidejte novou oblast detekce. Chcete-li odstranit oblast detekce, klepněte na tlačítko .
	4. Přetáhněte rámečky pole a nastavte požadovanou pozici a rozsah.
	5. Nastavte prahovou hodnotu času, citlivost a procento, aby kamera rozhodla, zda má hlásit alarm detekce vniknutí.
	6. Nastavte akce aktivace alarmu a plán aktivace podle potřeby. Podrobné kroky naleznete v popisu akcí vyvolaných alarmem v části Konfigurace alarmu detekce pohybu.
	7. Klikněte na možnost Save.

	Detekce obličeje
	1. Klikněte na možnost Setup > Intelligent > Smart Settings. Vyberte možnost  Face a poté klikněte na .
	2. Přetáhněte rámečky a nastavte požadovanou pozici a rozsah.
	3. Nastavte parametry detekce podle aktuálních potřeb.
	4. Nastavte akce aktivace alarmu a plán aktivace podle potřeby. Podrobné kroky naleznete v popisu akcí vyvolaných alarmem v části Konfigurace alarmu detekce pohybu.
	5. Klikněte na možnost Save.
	6. Klikněte na možnost Start Intelligent Analysis.

	Počítání osob
	1. Klikněte na možnost Setup > Intelligent > Smart Settings. Vyberte možnost  People Counting a poté klikněte na .
	2. Vyberte možnost Enable Passenger Flow Detection. Vyberte režim detekce, nastavte interval hlášení a citlivost.
	3. Klikněte na možnost Draw Detection Area a poté nakreslete detekční oblast v okně náhledu vlevo, např. čtverec.
	4. Klikněte na možnost Draw Entrance Direction a pak nakreslete směr v okně náhledu vlevo. Směr je obvykle svislý nebo nakloněný.
	5. Nastavte možnost Max. Size a Min. Size v části Filter by Object Size. Pouze objekty v rozmezí dané velikosti budou počítány; jiné budou odfiltrovány a nebudou započítány.
	6. Nastavte akce aktivace alarmu a plán aktivace podle potřeby. Podrobné kroky naleznete v popisu akcí vyvolaných alarmem v části Konfigurace alarmu detekce pohybu.
	7. Chcete-li obnovit výsledky počítání, klepněte na tlačítko Clear Counting Result.
	8. Klikněte na možnost Save.

	Automatické sledování
	1. Klikněte na možnost Setup > Intelligent > Smart Settings. Vyberte možnost Auto Tracking a poté klikněte na .
	2. Nastavte časový limit sledování (jednotka: sec) a poměr přiblížení.
	3. Klikněte na možnost Save.

	Detekce rozostření
	1. Klikněte na možnost Setup > Intelligent > Smart Settings. Vyberte možnost Defocus a poté klikněte na .
	2. Vyberte možnost Defocus Detection.
	3. Nastavte citlivost detekce a akce vyvolané alarmem podle potřeby. Podrobné kroky naleznete v popisu akcí vyvolaných alarmem v části Konfigurace alarmu detekce pohybu.
	4. Klikněte na možnost Save.

	Detekce změny scény
	1. Klikněte na možnost Setup > Intelligent > Smart Settings. Vyberte možnost Scene Change a poté klikněte na .
	2. Vyberte možnost Scene Change Detection.
	3. Nastavte citlivost detekce. Nastavte akce aktivace alarmu a plán aktivace podle potřeby. Podrobné kroky naleznete v popisu akcí vyvolaných alarmem v části Konfigurace alarmu detekce pohybu.
	4. Klikněte na možnost Save.

	Rozšířená nastavení
	Parametry fotografie
	1. Klikněte na možnost Setup > Intelligent > Advanced Settings. Klikněte na kartu Photo parameters .
	2. Nastavte původní obraz a jasnost miniatury.
	3. Klikněte na možnost Save.

	Parametry detekce
	1. Klikněte na možnost Setup > Intelligent > Advanced Settings. Klikněte na kartu Detection parameters.
	2. Vyberte režim detekce. Vyberte možnost Filter Repeated Motion Mode, aby se zabránilo opakovanému hlášení alarmů způsobenému opakovaným pohybem zjištěným ve sledovaném prostředí.
	3. Klikněte na možnost Save.



	Společná konfigurace alarmu
	Konfigurace alarmu detekce pohybu
	Oblast detekce
	1. Klikněte na možnost Setup > Events > Common Alarm > Motion Detection. Nastavte možnost Detection Mode na Area.
	2. V oblasti Detection Area klikněte na možnost  a přidejte novou detekční oblast. Chcete-li odstranit oblast detekce, klepněte na tlačítko .
	3. Klepnutím a přetažením myši nastavte detekční oblast.
	4. Nastavte citlivost detekce, velikost objektu a historii, aby se kamera rozhodla, zda má hlásit alarm detekce pohybu.
	5. Nastavte parametry alarmu.
	a. Není-li stejný alarm spuštěn v nastaveném čase, alarm se vymaže a stejný alarm se může nahlásit znovu.
	b. Je-li stejný alarm spuštěn v nastaveném čase, alarm nebude vymazán, dokud nevyprší čas vypršení alarmu. Pak může být opět hlášen stejný alarm.

	6. Nastavte akce, které mají být vyvolány alarmem detekcí pohybu a plánem.
	7. Klikněte na možnost Save.

	Mřížka detekce
	1. Klikněte na možnost Setup > Events > Motion Detection. Nastavte možnost Detection Mode na Grid.
	2. Detekční oblast může být na mřížce nepravidelná.
	3. Nastavte citlivost detekce, aby se kamera rozhodla, zda má hlásit alarm detekce pohybu (alarm viditelný na kompatibilním NVR).
	4. Nastavte parametry alarmu.
	a. Není-li stejný alarm spuštěn v nastaveném čase, alarm se vymaže a stejný alarm se může nahlásit znovu.
	b. Je-li stejný alarm spuštěn v nastaveném čase, alarm nebude vymazán, dokud nevyprší čas vypršení alarmu. Pak může být opět hlášen stejný alarm.

	5. Nastavte akce, které mají být vyvolány alarmem detekcí pohybu a plánem. Podrobné kroky naleznete v popisu akcí vyvolaných alarmem v části Oblast detekce v Konfigurace alarmu detekce pohybu.
	6. Klikněte na možnost Save.


	Konfigurace alarmu neoprávněné manipulace
	1. Klikněte na možnost Setup > Events > Common Alarm >Tampering Alarm.
	2. Vyberte možnost On pro Tampering Alarm.
	3. Nastavte citlivost detekce a dobu, po které se kamera rozhodne, zda má ohlásit alarm neoprávněné manipulace.
	4. Nastavte akce, které mají být aktivovány alarmem neoprávněné manipulace a plánem. Podrobné kroky naleznete v popisu akcí vyvolaných alarmem v části Konfigurace alarmu detekce pohybu.
	5. Klikněte na možnost Save.

	Konfigurace alarmu audio detekce
	1. Klikněte na možnost Setup > Events > Common Alarm >Audio Detection.
	2. Vyberte možnost Enable pro Audio Detection, vyberte typ detekce a nastavte rozdíl nebo prahovou hodnotu. Chcete-li zakázat audio detekci, zrušte zaškrtnutí políčka Enable.
	3. Nastavte akce aktivace alarmu a plán aktivace podle potřeby. Podrobné kroky naleznete v popisu akcí vyvolaných alarmem v části Konfigurace alarmu detekce pohybu.
	4. Klikněte na možnost Save.

	Konfigurace alarmového vstupu
	1. Klikněte na možnost Setup > Events > Common Alarm > Alarm Input.
	2. Vyberte alarm a nastavte název alarmu.
	3. Vyberte možnost N.O. nebo N.C. v závislosti na typu zařízení alarmového vstupu třetí strany. Pokud je například zařízení alarmového vstupu třetí strany normálně otevřeno, je nutné zde zvolit N.O., aby kamera mohla přijímat informace ze zařízení alarmové4
	4. Nastavte akce, které mají být spuštěny alarmovým vstupem a plánem. Podrobné kroky naleznete v popisu akcí vyvolaných alarmem v části Konfigurace alarmu detekce pohybu.
	5. Klikněte na možnost Save.

	Konfigurace alarmového výstupu
	1. Klikněte na možnost Setup > Events > Common Alarm > Alarm Output.
	2. Vyberte alarm a nastavte název alarmu.
	3. Nastavte stav na N.O. (výchozí nastavení) a nastavte dobu trvání alarmu.
	4. Nastavte akce, které mají být spuštěny alarmovým vstupem a plánem. Podrobné kroky naleznete v popisu akcí vyvolaných alarmem v části Konfigurace alarmu detekce pohybu.
	5. Klikněte na možnost Save.


	Úložiště – paměťová karty
	Nastavení úložiště v zařízení
	Manuální ukládání
	1. Klikněte na možnost Setup > Storage > Storage.
	2. Spusťte úložiště v zařízení a upravte nastavení podle potřeby. V následující tabulce jsou popsány některé hlavní parametry.
	3. Klikněte na možnost Save.

	Záznam dle plánu
	1. Klikněte na možnost Setup > Storage > Storage.
	2. Vyberte možnost Planned Storage a poté nastavte dobu, po kterou kamera zaznamená video na paměťovou kartu.
	3. Klikněte na možnost Save.


	Nastavení následného záznamu v mezipaměti.
	Zakázat úložiště v zařízení
	1. Klikněte na možnost Setup > Storage > Storage.
	2. Nastavte možnost Edge Storage na Disable (čímž deaktivujete manuální) a nastavte kapacitu videa.
	3. Klikněte na možnost Save.



	Údržba systému
	Zabezpečení
	Správa uživatelů
	Nastavení bezpečného přenosu dat
	1. Klikněte na možnost Setup > Network > Port.
	2. Zadejte číslo portu v textovém poli  HTTPS Port.
	3. Klikněte na tlačítko Save.
	4. Klikněte na možnost Setup > Security > Network Security > HTTPS.
	5. Vyberte možnost On pro HTTPS. Můžete podle potřeby importovat vlastní certifikát SSL.
	6. Klikněte na možnost Save.

	Ověřování
	1. Klikněte na možnost Setup > Security > Network Security > Authentication.
	2. Vyberte režim ověřování a klepněte na tlačítko Save.

	Skrýt informace o dodavateli
	1. Klikněte na možnost Setup > Security > Registration Info.
	2. V části Registration Info vyberte položku On.
	3. Klikněte na možnost Save.

	Vazba APR
	1. Klikněte na možnost Setup > Security > Network Security > ARP Protection.
	2. Zaškrtnutím políčka povolíte funkci vazby ARP a nastavíte adresu brány MAC.
	3. Klikněte na možnost Save.

	Filtrování IP adres
	1. Klikněte na možnost Setup > Security > Network Security > IP Address Filtering.
	2. Vyberte možnost On a povolte filtrování IP adres
	3. Vyberte režim filtrování a přidejte IP adresu (adresy).
	4. Klikněte na možnost Save.

	Přístupová politika
	1. Klikněte na možnost Setup > Security > Network Security > Access Policy.
	2. Vyberte možnost On a povolit telnet, přátelské heslo a ověřování MAC.
	3. Klikněte na možnost Save.

	Vodoznak
	1. Klikněte na možnost Setup > Security > Watermark.
	2. Výběr možnosti On aktivujte vodoznak a poté zadejte obsah vodoznaku.
	3. Klikněte na možnost Save.


	Nastavení systémového času
	Manuální nastavení nebo synchronizace systémového času
	1. Klikněte na možnost Setup > Common > Time a potom klepněte na kartu Time.
	2. Vyberte režim synchronizace.
	3. Nastavte správné časové pásmo a systémový čas. Také můžete kliknout na možnost Sync with Computer Time a synchronizovat nastavení času vaší kamery s časem vašeho počítače.
	4. Klikněte na možnost Save.

	Synchronizace se serverem NTP
	1. Klikněte na možnost Setup > Common > Time a potom klepněte na kartu Time.
	2. Nastavte možnost Sync Mode na Sync with NTP Server a poté nastavte adresu IP serveru NTP a interval aktualizace.
	3. Klikněte na možnost Save. Kamera bude periodicky synchronizovat čas se serverem NTP.

	Nastavení DST
	1. Klikněte na možnost Setup > Common > Time a potom klepněte na kartu DST.
	2. Nastavte možnost On pro DST, nastavte čas začátku, čas ukončení a zkreslení DST.
	3. Klikněte na možnost Save.


	Nastavení serverů
	Inteligentní server
	1. Klikněte na možnost Setup > Common > Server a poté klikněte na kartu Intelligent Server.
	2. Nastavte adresu IP serveru TMS a proveďte další nastavení.
	3. Klikněte na možnost Save.


	Konfigurace režimu sériového portu
	Ovládání PTZ
	1. Klikněte na možnost Setup > System > Ports & Devices a poté klikněte na kartu Serial Port.
	2. Vyberte možnost PTZ Control z rozevírací nabídky Port Mode. V následující tabulce jsou popsány některé hlavní parametry.
	3. Klikněte na možnost Save.

	Transparentní kanál
	1. Klikněte na možnost Setup > System > Ports & Devices a poté klikněte na kartu Serial Port.
	2. Vyberte možnost Trans-Channel z rozevírací nabídky Port Mode.
	3. Vyberte možnost Enable pro Trans-Channel.
	4. Zadejte cílovou adresu IP a číslo portu (adresa IP a číslo portu, k němuž se transparentní kanál připojuje).
	5. Klikněte na možnost Save.

	OSD
	1. Klikněte na možnost Setup > System > Ports & Devices a poté klikněte na kartu Serial Port.
	2. Vyberte možnost OSD z rozevírací nabídky Port Mode. Vyberte možnost Enable OSD Report (takže data OSD budou nahrána na platformu).
	3. Klikněte na možnost Save.

	Transparentní kanál ONVIF
	1. Klikněte na možnost Setup > System > Ports & Devices a poté klikněte na kartu Serial Port.
	2. Nastavte možnost Port Mode na Select Trans-Channel via ONVIF.
	3. Klikněte na možnost Save.


	Řízení stěrače
	1. Klikněte na možnost Setup > System > Ports & Devices a poté klikněte na kartu External Device.
	2. Nastavte řídicí režim stěrače. V následující tabulce jsou popsány některé hlavní parametry.

	Zobrazení stavu zařízení
	1. Klikněte na možnost Setup > Common > Basic Info.
	2. Klikněte na možnost  Refresh pro nejnovější informace o stavu.
	3. Zobrazení informací o zařízení.

	Stav úložiště snímků
	1. Klikněte na možnost Photo.
	2. Klikněte na možnost Refresh pro aktualizaci stavu úložiště.
	3. Snímky můžete exportovat nebo odstranit v oblasti Image List.

	Upgrade zařízení
	1. Klikněte na možnost Setup > System > Maintenance.
	2. V části Software Upgrade klikněte na možnost Browse a vyberte správný soubor upgradu.
	3. Klikněte na možnost Upgrade a pak potvrďte spuštění. Kamera se po dokončení upgradu automaticky restartuje. Některá zařízení podporují aktualizaci zaváděcího programu. Chcete-li provést upgrade, vyberte možnost Upgrade Boot Program.
	4. Můžete kliknout na možnost Detect a zkontrolovat nové verze dostupné pro upgrade pomocí cloudu.

	Restart systému
	1. Klikněte na možnost Setup > System > Maintenance.
	2. V části Device Restart klikněte na možnost Restart. Po potvrzení operace se zařízení restartuje.

	Import a export souboru konfigurace systému
	1. Klikněte na možnost Setup > System > Maintenance.
	2. Chcete-li importovat konfigurace, které jste zálohovali, klepněte na tlačítko Browse vedle tlačítka Import a vyberte konfigurace, které chcete importovat. Poté klepněte na tlačítko Import. Zobrazí se výsledek.
	3. Chcete-li exportovat konfigurace, klepněte na tlačítko Export a vyberte cílovou složku.
	4. Chcete-li obnovit výchozí konfigurace, klepněte na tlačítko Default a pak potvrďte operaci. Zařízení se restartuje a obnoví výchozí konfigurace.

	Shromažďování diagnostických informací
	1. Klikněte na možnost Setup > System > Maintenance.
	2. V části Diagnosis Info klikněte na možnost Export a vyberte cílovou složku.

	Konfigurace zaostření
	1. Klikněte na možnost Setup > System > Maintenance.
	2. V části Focus konfigurujte možnost Min. Focus Distance (jednotka: cm) a Max. Zoom Ratio.
	3. Klikněte na tlačítko OK.

	Montážní výška zařízení
	1. Klikněte na možnost Setup > System > Maintenance.
	2. Zadejte skutečnou výšku namontované infračervené kopule od země.
	3. Klikněte na tlačítko OK.

	Parametr kamer rybí oko
	1. Klikněte na možnost Live View > Mount. Vyberte režim montáže. Zvolený režim montáže musí odpovídat aktuálnímu režimu montáže.
	2. Nastavte parametry. V následující tabulce jsou popsány některé hlavní parametry.



	4   Živé zobrazení
	Panel nástrojů živého zobrazení
	Zobrazení určité oblasti obrazu
	Použití digitálního přiblížení
	1. Na stránce Live View klikněte na možnost  na panelu nástrojů.
	2. Klepnutím a podržením tlačítka myši a přetažením shora dolů (nakreslete obdélník) určete příslušnou oblast. Chcete-li obnovit původní velikost obrazu a přiblížit jiné oblasti obrazu, klepněte pravým tlačítkem myši.
	3. Pro ukončení klepněte na tlačítko .

	Použití oblast ostření
	1. Na stránce Live View klikněte na možnost  na panelu nástrojů.
	2. Klepnutím a podržením tlačítka myši a přetažením shora dolů (nakreslete obdélník) určete příslušnou oblast.
	3. Pro ukončení klepněte na tlačítko .

	Použití 3D polohování
	1. Na stránce Live View klikněte na možnost  na panelu nástrojů.
	2. Klepnutím a podržením tlačítka myši a přetažením shora dolů (nakreslete obdélník) určete příslušnou oblast. Při obráceném přetažení (od horní části) dojde ke zmenšení.
	3. Pro ukončení klepněte na tlačítko .


	Živé zobrazení kamery – rybí oko

	5   Přehrávání videa a stahování pomocí úložiště v zařízení
	Přehrávání videa
	1. Klikněte na možnost Playback na domovské stránce.
	2. Vyberte datum z kalendáře.
	3. Klikněte na možnost Query.
	4. V části Results klidně za dvakrát na časové období a začněte přehrávat záznam.

	Stažení
	1. Klikněte na možnost Playback na domovské stránce.
	2. Vyhledávání videa v určeném období. Výsledky se zobrazí v seznamu.
	3. Vyberte video a klikněte na možnost Download. Video se stáhne z místní cesty z paměťové karty (místní cesta může být změněna v části Local Settings).
	4. Kliknutím na možnost Open zobrazíte složku, v níž je stažené video uloženo.


	6   Ovládání PTZ
	Panel nástrojů ovládání PTZ
	Nastavení hlídky podle přednastavených pozic
	Nastavení přednastavených pozic
	Přidat přednastavenou pozici
	1. Na stránce Live View klikněte na možnost Preset na panelu nástrojů.
	2. Kameru nastavte tak, aby ukazovala požadovaným směrem.
	3. Přizpůsobte přiblížení a zaostření podle potřeby, abyste získali optimální obraz.
	4. Kliknutím na možnost  ji přidáte jako přednastavenou pozici. Zadejte číslo a název přednastavené pozice a klepněte na tlačítko OK.

	Přechod na přednastavenou pozici
	1. Na stránce Live View klikněte na možnost Preset na panelu nástrojů.
	2. Klikněte na  pro přednastavenou pozici. Kamera PTZ přejde na přednastavenou pozici.

	Odstranění přednastavené pozice.
	1. Na stránce Live View klikněte na možnost Preset na panelu nástrojů.
	2. Klikněte na možnost  pro výběr určité přednastavené pozice a poté potvrďte odstranění.


	Nastavení hlídky
	Přidání trasy hlídky
	1. Na stránce Live View klikněte na možnost Patrol na panelu nástrojů.
	2. Klikněte na .
	3. Na stránce Add Patrol zadejte ID a název trasy a klepnutím na tlačítko Add přidejte určitou akci hlídky. Je povoleno až 64 akcí. Každý řádek obsahuje dvě akce, při kterých je nastaven typ akce na Move Direction a Zoom, takže je povoleno 32 akcí. Pomocí Q
	4. Klikněte na tlačítko OK.

	Záznam trasy hlídky
	1. Na stránce Live View klikněte na možnost Patrol na panelu nástrojů.
	2. Kliknutím na možnost  spustíte záznam trasy hlídky. Během záznamu můžete nastavit směr a přiblížení kamery. Systém zaznamená pohyb a stopu kamery a přidá je do seznamu akcí.
	3. Klepnutím na  dokončíte nahrávání. Poté se trasa hlídky automaticky uloží jako trasa režimu. Kliknutím na možnost  spustíte vyhlídku nebo kliknutím na  odstraníte trasu režimu.

	Vytvoření plánu hlídky
	1. Na stránce Live View klikněte na možnost Patrol na panelu nástrojů.
	2. Klikněte na . Zobrazí se stránka pro nastavení plánů hlídky.
	3. Nastavte správný čas a trasu hlídky.
	4. Vyberte možnost Enable Patrol Plan.
	5. Klikněte na tlačítko OK.

	Spuštění trasy hlídky
	1. Na stránce Live View klikněte na možnost Patrol na panelu nástrojů.
	2. Klikněte na  pro trasu hlídky, kterou chcete spustit.

	Úprava trasy hlídky
	1. Na stránce Live View klikněte na možnost Patrol na panelu nástrojů.
	2. Klikněte na  pro trasu hlídky, kterou chcete upravit, a upravte požadovaná nastavení.

	Odstranění trasy hlídky
	1. Na stránce Live View klikněte na možnost Patrol na panelu nástrojů.
	2. Klikněte na  pro trasu hlídky, kterou chcete odstranit a poté potvrďte odstranění.



	Nastavení výchozí polohy
	1. Klikněte na možnost Setup > PTZ > Home Position.
	2. Vyberte režim a ID.
	3. Klikněte na možnost Save.

	Vzdálené ovládání PTZ
	1. Klikněte na možnost Setup > PTZ > Remote Control.
	2. Vyberte možnost On pro povolení Remote Control. Nastavte port pro naslouchání a kód adresy. V následující tabulce jsou popsány některé hlavní parametry.
	3. Klikněte na možnost Save.

	Limit PTZ
	1. Klikněte na možnost Setup > PTZ > PTZ Limit.
	2. Pomocí směrových tlačítek otočte kameru do určené polohy.
	3. Kliknutím na možnost  nastavíte aktuální polohu jako limit. Například klikněte na  v horní části pro nastavení horního limitu. Kliknutím na  otočíte kameru do aktuální polohy, pokud byl změněn směr.
	4. Opakujte výše uvedené kroky, chcete-li nastavit všechny limity podle potřeby (nahoru, dolů, doleva, doprava).
	5. Klikněte na možnost Save.
	6. Kliknutím na možnost Start PTZ Limit nastavení použijete.
	7. Kliknutím na možnost  odstraníte nastavení a resetuje limit.

	Obnovení hlídky
	1. Klikněte na možnost Setup > PTZ > Patrol.
	2. Nastavte čas, kdy se hlídka obnoví.
	3. Klikněte na možnost Save.


	Dodatek A – glosář
	Příloha B – často pokládané dotazy
	Co dělat, když se po prvním přihlášení k počítači se systémem Windows 7 neobjeví výzva k instalaci technologie ActiveX
	1. Klikněte na nabídku Start a pak na možnost Control Panel.
	2. Do vyhledávacího pole zadejte příkaz uac a potom klepněte na tlačítko Change User Account Control Settings.
	3. Přesuňte posuvník do polohy Never Notify a klepněte na tlačítko OK.
	4. Po vypnutí UAC se znovu přihlaste.

	Co dělat, pokud selže instalace technologie ActiveX
	Co dělat, když živé video selže po prvním přihlášení


